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重要安全資訊

重要安全資訊
本手冊包含使用者必須遵循的資訊和警告，以確保操作安全並使產品保持在安全狀態。

為安全維修本產品，本節結尾另提供其他資訊。( 請參閱頁vii，維修安全摘要)

一般安全摘要
請僅依照指示使用此產品。請檢視下列的安全警告以避免傷害，並預防對此產品或任何相關產品的損
害。請詳讀所有指示。請保留這些指示以供日後參考。

遵守當地和國家安全規章。

為正確及安全地操作產品，除本手冊中所指定的安全警告外，請務必依照一般可接受的安全程序進行
操作。

本產品設計僅供經過訓練的人員使用。

僅有經過訓練並瞭解所涉及危險的合格人員，才能卸除機蓋進行修復、維修和調整作業。

使用之前，請務必連接已知電源檢查產品，以確保機器能正確運作。

本產品不適用於偵測危險電壓。

請使用個人防護設備，以避免當危險的導體露出時受到電擊和弧光爆破的傷害。

使用此產品時，您可能需要運作較大系統的其他部分。請閱讀其他元件手冊的安全章節，了解操作系
統的相關警告與注意事項。

當本設備與系統結合使用時，系統安全由系統的組裝人員負責。

避免火源或身體傷害
使用適當的電源線: 僅可使用本產品所指定以及該國使用認可的電源線。

請勿使用其他產品所提供的電源線。

將產品接地: 本產品是透過電源線的接地導線與地面連接。為了避免電擊，接地導線必須連接到地
面。在與產品的輸入與輸出端子連接之前，請確定產品已正確地接地。

電源中斷連接: 電源線中斷電源與產品的連接。請參閱有關位置的說明。請勿將設備放置在不便操
作電源線的位置；電源線必須隨時維持於可存取狀態，以便於必要時能夠快速中斷電源。

正確地連接與中斷連接: 當探棒或測試線與電壓來源連接時，請勿連接它們或中斷與它們的連接。

務必使用產品提供的絕緣電壓探棒、測試線與轉接器，或 Tektronix 表示適用於產品的配件。

觀察所有的端子功率: 為了避免火災或是電擊的危險，請注意產品上的功率及標記。在與產品連接
之前，請先參閱產品手冊以便進一步瞭解有關功率的資訊。請勿超過產品、探棒或配件最低額定單一
元件的量測類別 (CAT) 功率及電壓或電流功率。當使用一比一測試線時請小心謹慎，因探棒頭電壓會
直接傳送至產品。

請勿將電壓加至任何端子，包括共同端子，這會超過端子的最大功率。

請勿以超過一般端子的額定電壓浮接該端子。
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如果是 MSO/DPO70K 和 DPO7K 儀器，本產品上的量測端子不可用於連接至主要或類型 II、III 或 IV 電
路。

請勿在蓋子未蓋上之前即進行操作: 當蓋子或面板未蓋上或箱子打開時，請勿操作本產品。否則
可能會發生危險電壓外洩。

避免電路外露: 當電源開啟時，請勿碰觸外露的連接線路及元件。

懷疑有故障時請勿操作: 若您懷疑此產品已遭損壞，請讓合格的維修人員進行檢查。

請停用已損壞的產品。請勿使用已損壞或未正確操作的產品。如果對產品的安全有疑慮，請關閉機器
並請拔掉電源線。清楚標示產品以避免進一步操作。

使用前，請檢查電壓探棒、測試線和配件是否有機械性損壞，並在損壞時更換。如果探棒或測試線已
損壞，或是有金屬外露或指示器磨損的情形，則請勿使用。

在使用產品之前，請仔細檢查產品外部。查看是否有缺少零件的情況。

請務必使用指定的更換零件。

請勿在潮濕的狀態下操作: 如果將裝置自寒冷的環境移至溫熱的環境，可能會發生水氣凝結的情況。

請勿在易燃易爆的空氣中操作:
請維持產品表面的清潔與乾燥: 清理產品前請先移除輸入訊號。

保持空氣的流通: 請參考手冊中的安裝說明以瞭解有關如何安裝產品使其具有良好通風的詳細資訊。

產品上的插槽和開口是做為通風之用，請勿將其覆蓋以免阻礙通風。請勿將物件推入任何開口中。

請提供安全的工作環境: 請隨時將產品置於方便檢視顯示器及指示器的位置。

請避免不當或常時間使用鍵盤、印表機及按鈕盤。不當或長時間使用鍵盤或印表機，可能會導致嚴重
的傷害。

請確定工作區符合適用的人體工程學標準。請詢問人體工程學專家以避免壓力傷害。

當抬舉及攜帶產品時，請謹慎小心。本產品提供提把以便於抬舉及攜帶。

警告。 本產品頗具重量。為了降低身體傷害或裝置受損的風險，當抬舉或攜帶產品時，請尋求協助。

在工作台上重新定位/抬舉產品時，請使用次要握把。為避免因儀器掉落而受傷，攜帶儀器時請使用
主要提把。

請務必只用本產品所指定的 Tektronix 框架硬體。
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維修安全摘要
＜維修安全摘要＞一節中含有安全維修產品所需的其他資訊。只有合格的維修人員方可執行維修程
序。在執行任何維修程序之前，請詳細閱讀＜維修安全摘要＞和＜一般安全摘要＞章節。

避免電擊: 請勿觸摸暴露在外的接線。

請勿獨自進行維修: 除非有另一名能夠進行急救及復甦術的人員在場，否則請勿進行本產品的內部
維修或調整。

中斷電源連接: 為避免遭受電擊，在卸下任何機蓋或面板、或開啟機殼進行維修之前，請先關閉產
品電源，並將電源線從主電源拔下。

若要在開啟電源的情況下進行維修，請特別小心: 本產品可能存在危險電壓或電流。在移除保護
面板、進行焊接或更換元件時，請中斷電源、卸下電池 (如果可以的話) 並中斷測試線的連接。

維修後請確認安全: 維修後，請務必重新檢查接地線的連續性以及主機的絕緣強度。
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本手冊中的術語
本手冊可能會出現下列術語：

警告。 警告聲明中指明了可能導致受傷或喪命的情況或操作。

小心。 小心聲明中指明了可導致損壞此產品或其他物品的情況或操作。

產品上的符號與術語
這些術語可能會出現在產品上：

「DANGER」(危險) 表示當您看到此標誌時可能會有立即受傷的危險。

「WARNING」(警告) 表示當您看到此標誌時並不會有立即受傷的危險。

「CAUTION」(小心) 表示可能損及財產 (包括本產品) 的危險。

當產品上出現此符號標示時，請務必查閱手冊以找出潛在危險的性質，以及避免發生危險
應採取的行動。(本手冊中也會使用此符號指引使用者參考功率資訊)。

以下符號可能會出現在產品上：
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相容資訊
本節將列出儀器所依循的 EMC (電磁相容)、安全和環境標準。

符合 EMC 的規範
EC 符合性聲明 - EMC
符合電磁相容性指示 2004/108/EC 目標。經證實符合歐盟官方期刊所列出之如下規格：

EN 61326-1:2006、EN 61326-2-1:2006: 量測、控制和實驗室使用之電子設備必須遵守的 EMC需
求。 1 2 3

CISPR 11:2003。輻射和傳導放射，群組 1、等級 A。

IEC 61000-4-2:2001。靜電釋放耐受性

IEC 61000-4-3:2002。RF 電磁場耐受性 4

IEC 61000-4-4:2004。電磁快速暫態/突波耐受性

IEC 61000-4-5:2001。電源線突增耐受性

IEC 61000-4-6:2003。傳導 RF 耐受性 4

IEC 61000-4-11:2004。電壓驟降和干擾耐受性

EN 61000-3-2:2006: AC 電源線諧波發射

EN 61000-3-3:1995: 電壓變化、波動和閃爍

歐洲聯絡人:
Tektronix UK, Ltd.
Western Peninsula
Western Road
Bracknell, RG12 1RF
United Kingdom

1 本產品僅適用於非住宅區。用於住宅區可能會造成電磁干擾。

2 當本儀器連接測試物品時，發射層級可能會超過這項標準要求。

3 在進行內部連接時，您必須使用低 EMI 遮罩纜線，例如以下的 Tektronix 零件編號或同等級產品：012-0991-01、
012-0991-02 或 012-0991-03 GPIB 纜線；012-1213-00 (或 CA 零件編號 0294-9) RS-232 纜線；012-1214–00 Centronics 纜
線；或 LCOM 零件編號 CTL3VGAMM-5 VGA 纜線。使用 Ref Out 接頭適用的 012-0482-00 纜線。

4 當示波器位於連續呈現的電磁現象時適用的性能準則：MSO70000C/DX、DPO70000C/DX 和 DPO7000：10 mV/格至 1
V/格：≤0.4 格波形位移，或峰對峰雜訊增加 ≤0.8 格。MSO5000 和 DPO5000：≤4.0 格波形位移，或峰對峰雜訊增加
≤8.0 格。

5

澳洲/紐西蘭符合性聲明 - EMC
本儀器符合 Radiocommunications Act 中訂定 EMC 條款的下列標準，並符合 ACMA：
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CISPR 11:2003。輻射和傳導放射，群組 1，等級 A，並符合 EN 61326-1:2006 和 EN 61326-2-1:2006。

澳洲 / 紐西蘭聯絡人:

Baker & McKenzie
Level 27, AMP Centre
50 Bridge Street
Sydney NSW 2000, Australia

安全符合性
本節將列出產品所依循的安全標準及其他安全符合性資訊。

EU 符合性聲明 - 低電壓
經證實符合如下歐盟官方期刊所列出之規格：

低電壓指示 2006/95/EC。

EN 61010-1。量測、控制和實驗室使用之電子設備必須遵守的安全需求 – 第一部分：一般需求。

EN 61010-2-030。量測、控制和實驗室使用之電子設備必須遵守的安全需求 – 第 2-030 部分：測試
和量測電路的特殊需求。

美國國家認可測試實驗室清單
UL 61010-1。量測、控制和實驗室使用之電子設備必須遵守的安全需求 – 第一部分：一般需求。

UL 61010-2-030。量測、控制和實驗室使用的電子設備必須遵守的安全需求 – 第 2-030 部分：測試
和量測電路的特殊需求。

加拿大檢定證明
CAN/CSA-C22.2 No. 61010-1。量測、控制和實驗室使用之電子設備必須遵守的安全需求 – 第一部
分：一般需求。

CAN/CSA-C22.2 No. 61010-2-030。量測、控制和實驗室使用之電子設備必須遵守的安全需求 – 第
2-030 部分：測試和量測電路的特殊需求。

其他符合性
IEC 61010-1。量測、控制和實驗室使用之電子設備必須遵守的安全需求 – 第一部分：一般需求。

IEC 61010-2-030。量測、控制和實驗室使用之電子設備必須遵守的安全需求 – 第 2-030 部分：測試
和量測電路的特殊需求。

設備類型
測試和量測設備。
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相容資訊

安全等級
等級 1 – 接地性產品。

污染等級說明
針對周圍環境和產品內部所進行的污染量測。通常產品內部環境會視為相同於其外部環境。本產品只
適用於已評估的環境。

污染等級 1。不會產生污染，或只會產生乾燥而非傳導式的污染物。這項種類的產品通常會加以密
封、氣密封存或是放置在無塵室中。

污染等級 2。通常只會產生乾燥而非傳導式的污染物。必須預防因凝結所發生的暫時傳導性。這種
場所通常是辦公室∕居家環境。暫時性凝結只會在產品不使用時發生。

污染等級 3。傳導式污染，或是由於凝結導致乾燥、非傳導式污染成為傳導式污染。這是指沒有控
制溫度或溼度的遮蔽場所。該區域可避免陽光直曬、雨水或是直接風吹。

污染等級 4。指透過傳導性灰塵、雨水或雪產生永久傳導性的污染。一般戶外場所。

污染等級級別
污染等級 2 (依據 IEC 61010-1 定義)。評估僅限用於室內、乾燥環境。

IP 級別
IP20 (依照 IEC 60529 所定義)。

量測及過電壓類別說明
您可以根據下列一或多個類別來評估本產品量測端子的主電壓 (請參閱產品上或手冊中所標示的特定
功率)。

類別 II。電路直接連接至建築物配線的使用點 (電源插座和類似點)。

類別 III。在建築物配線及配送系統中。

類別 IV。在建築物電力供應來源處。

注意。 僅主電源供應電路適用過電壓類別級別。僅量測電路適用量測類別級別。產品中的其他電路
不適用上述兩種級別。

主電源過電壓類別級別
過電壓類別 II (依據 IEC 61010-1 定義)。
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環境注意事項
本節提供此產品對環境所造成的影響之相關資訊。

產品報廢處理
回收儀器或元件時，請參閱下列指引：

設備回收: 本設備的生產作業需要自然資源之回收與利用。若在產品報廢時未正確處理，此設備可
能含有對環境或人類健康有害的物質。為了避免此類物質釋放到環境，並減少使用自然資源，建議您
透過適當系統回收此產品，以確保大部分的材料均適當地回收或再利用。

依照歐盟廢棄電子電器設備 (WEEE) 和電池指令要點指示 2002/96/EC 和 2006/66/EC，此符
號表示此產品遵守歐盟要求。如需回收選項的詳細資訊，請參閱 Tektronix 網站 (www.tek-
tronix.com) 支援/服務區。

水銀標示: 本產品使用含水銀的 LCD 背光燈。廢棄處理必須符合環保規範。請聯絡您當地的權責機
關。若您位於美國，請參閱 E-cycling Central 網頁 (www.eiae.org)，以取得棄置或回收資訊。 1

1 此標示不適用於 MSO5000 和 DPO5000 儀器。MSO5000 和 DPO5000 儀器使用不含水銀的 LED 背光。

高氯酸鹽材料: 此產品包含一或多種 CR 鋰電池類型。根據加州法律，CR 鋰電池被歸類為高氯酸鹽
材料，必須採取特殊處理。請參閱 www.dtsc.ca.gov/hazardouswaste/perchlorate 取得其他資訊。

危險物質之限用
本產品分類為工業監視與控制儀器，在 2017 年 7 月 22 日前不需要符合 recast RoHS Directive 2011/65/EU
的物質限用。
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前言
本手冊說明 MSO/DPO7000DX 系列、MSO/DPO70000C 系列、DPO7000C 系列和 MSO/DPO5000 系列儀器
的安裝和操作方式。本手冊將介紹基本操作及概念。如需更多詳細資訊，請參閱儀器的線上說明。本
手冊支援以下儀器：

MSO73304DX 和 DPO73304DX

MSO72504DX 和 DPO72504DX

MSO72304DX 和 DPO72304DX

MSO72004C 和 DPO72004C

MSO71604C 和 DPO71604C

MSO71254C 和 DPO71254C

MSO70804C 和 DPO70804C

MSO70604C 和 DPO70604C

MSO70404C 和 DPO70404C

DPO7354C

DPO7254C

DPO7104C

DPO7054C

MSO5204 和 DPO5204

MSO5104 和 DPO5104

MSO5054 和 DPO5054

MSO5034 和 DPO5034

主要功能
MSO70000C/DX、DPO70000DX、DPO70000C、DPO7000C、MSO5000 和 DPO5000 系列儀器有助您確認、
偵錯和辨識電子圖。主要功能包括：

4 個類比通道的機型為 33 GHz 頻寬與 50 GS/s 即時取樣率，2 個類比通道的機型為 100 GS/s 即時取
樣率 (MSO73304DX 和 DPO73304DX)

4 個類比通道的機型為 25 GHz 頻寬與 50 GS/s 即時取樣率，2 個類比通道的機型為 100 GS/s 即時取
樣率 (MSO72504DX 和 DPO72504DX)

4 個類比通道的機型為 23 GHz 頻寬與 50 GS/s 即時取樣率，2 個類比通道的機型為 100 GS/s 即時取
樣率 (MSO72304DX 和 DPO72304DX)

4 個類比通道的機型為 20 GHz 頻寬與 50 GS/s 即時取樣率，2 個類比通道的機型為 100 GS/s 即時取
樣率 (MSO72004C 和 DPO72004C)

4 個類比通道的機型為 16 GHz 頻寬與 50 GS/s 即時取樣率，2 個類比通道的機型為 100 GS/s 即時取
樣率 (MSO71604C 和 DPO71604C)
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4 個類比通道的機型為 12.5 GHz 頻寬與 50 GS/s 即時取樣率，2 個類比通道的機型為 100 GS/s 即時
取樣率 (MSO71254C 和 DPO71254C)

4 個類比通道的機型為 8 GHz 頻寬與 25 GS/s 即時取樣率 (MSO70804C 和 DPO70804C)

4 個類比通道的機型為 6 GHz 頻寬與 25 GS/s 即時取樣率 (MSO70604C 和 DPO70604C)

4 個類比通道的機型為 4 GHz 頻寬與 25 GS/s 即時取樣率 (MSO70404C 和 DPO70404C)

所有波道為 3.5 GHz 頻寬與 10 GS/s 即時取樣率、波道 1 為 40 GS/s (DPO7354C)

所有通道為 2.5 GHz 頻寬與 10 GS/s 即時取樣率、通道 1 為 40 GS/s (DPO7254C)

所有通道為 1 GHz 頻寬與 5 GS/s (10 GS/s 選配) 即時取樣率、通道 1 為 20 GS/s (40 GS/s 選配)
(DPO7104C)

所有波道為 500 GHz 頻寬與 5 GS/s 即時取樣率、波道 1 為 20 GS/s (DPO7054C)

2 個類比波道為 2 GHz 頻寬與 10 GS/s 即時取樣率 (MSO5204 和 DPO5204)

2 個類比波道為 1 GHz 頻寬與 10 GS/s 即時取樣率 (MSO5104 和 DPO5104)

所有類比波道為 500 GHz 頻寬與 5 GS/s 即時取樣率 (MSO5054 和 DPO5054)

所有類比波道為 350 GHz 頻寬與 5 GS/s 即時取樣率 (MSO5034 和 DPO5034)

當「加強型頻寬」功能啟用時，便可套用擴充頻寬和拉平帶通頻率的「數位訊號處理 (DSP)」濾波
功能。「加強型頻寬」在波道達到最大取樣率時，經由已啟用的波道提供配比響應。您可以將最
大頻寛限制在 500 MHz，讓雜訊比例下的訊號達到最佳化。加強型頻寬延伸至某些高效能探棒和頭
的探棒頭。

記錄長度最多可達 5 億個取樣，視不同型號和選項而定

最高可達 1.0% DC 垂直增益精確度； 依不同型號而有差異

4 個類比輸入波道 (不用高解析度模式時，每個波道有 8 位元解析度)，輔助觸發輸入和輸出

MSO70000C/DX 和 MSO5000 系列儀器上可使用 16 個數位通道，另外 MSO70000C/DX 系列儀器上還
可使用額外的 1 個時脈通道

iCapture 可讓您在 MSO70000C/DX 系列儀器上分析數位通道的類比特性

取樣、包封、峰值檢測、高解析度、WfmDB (Waveform Database)、平均值和 FastAcq 等擷取模式

附擴充的 GPIB 指令程式和訊息介面的完整可程式化能力

MSO70000C/DX、DPO70000C/DX 和 DPO7000C 系列儀器上可使用含靈活 A 和 B 觸發事件和邏輯限
定觸發的 PinPoint 觸發

MSO5000 和 DPO5000 系列儀器上可使用一組完整的觸發

可選擇的「觸發位置更正」可以更精確的放置觸發並且滅少抖動。

部分型號或選項可提供業界標準的串列觸發、串列樣式觸發和樣式鎖定觸發等功能。

在 MSO70000C/DX 和 MSO5000 系列儀器的數位通道上觸發

視覺觸發是一種根據儀器顯示器所顯示形狀觸發的直覺式方法 (選擇性)

功能強大的內建測量能力，包括有長條圖、自動測量、眼狀圖測量和測量統計值。

採用數學運算方式來組合波形，建立支援資料分析工作的波形。在數學方程式中使用任意濾波器。
使用頻譜分析來分析頻域中的波形。

xiv MSO/DPO70000DX、MSO/DPO70000C、DPO7000C 和 MSO/DPO5000 系列使用者手冊



前言

支援波型資料漸層的大型 12.1 英吋 (307.3 毫米) [10.4 英吋 (264 毫米) MSO5000 和 DPO5000] 高解析
度 XGA 彩色螢幕，以便顯示取樣密度。可分別顯示 10 格水平和垂直刻度。

MSO5000 和 DPO5000 上可使用管理長記錄長度的 Wave Inspector 控制項，包含縮放和飛梭、播放和
暫停，以及搜尋和標記

MSO5000 上提供 MagniVu 60.6 ps 解析度和高速數位取樣率

最多可以同時檢視並比較 4 個縮放區域的 MultiView Zoom 功能。可一次鎖定並手動∕自動捲動最
多 4 個縮放區域。可控制縮放視窗內的波形顯示。

在波形上自動搜尋並標記特定事件

使用 DDR Memory Technology Analysis (DDR 記憶體技術分析) 選項的自動 DDR 分析

可自訂的 MyScope 控制視窗

可從水平刻度，分別控制取樣率和記錄長度

直觀的圖形使用者介面 (UI)，其中內建了可顯示於螢幕的線上說明

內部可移除式儲存磁碟

一系列的探棒解決方案

說明文件
請參閱下表，了解可用於本產品的各種資訊及其位置。

相關主題 說明文件

安裝和操作 (概要) 使用者手冊。提供一般操作資訊。

深入的操作和使用者介面說明 線上說明。提供使用儀器功能的詳細指示說明。從Help (說明)
按鈕存取線上說明或 Help (說明) 功能表，取得螢幕所示控制
項和元件的相關資訊。 ( 請參閱頁24，存取線上說明)

程式編寫指令 程式編寫指南 (收錄於文件瀏覽器，或在www.tektronix.com/man-
uals 線上取得)。包括 GPIB 指令的語法。

服務資訊 服務手冊 (收錄於文件瀏覽器，或在 www.tektronix.com/manuals
線上取得)。

本手冊使用慣例
本手冊使用以下圖示。

順序步驟 前面板電源 連接電源 網路 PS2 SVGA USB
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安裝儀器

安裝儀器
請拆封儀器，並檢查您已收到所有列於「標準配件」的項目。線上說明會列出建議的配件、探棒、儀
器選配項目和升級。若需最新資訊，請前往 Tektronix 網站 (www.tektronix.com)。

標準配件
配件 Tektronix 零件號碼

MSO70000C/DX 、 DPO70000C/DX 、 DPO7000C 、 MSO5000 和
DPO5000 系列數位螢光示波器使用者手冊

071-2980-xx

高 效 能 示 波 器 最 佳 實 務 使 用 者 手 冊 (MSO70000C/DX 、
DPO70000C/DX 和 DPO7000C 系列)

071-2989-xx

線上說明 (產品軟體的一部份) —

性能驗證 (收錄於文件瀏覽器) 077-0063-xx

程式編寫線上指南 (收錄於文件瀏覽器) 077-0010-xx

NIST、Z540-1 和 ISO9000 校準證書 —

一個 TekConnect 轉接頭 (僅 MSO/DPO70000C/DX 型號適用) TCA-BNC

四個 TekConnect 轉接頭 (僅 MSO/DPO70000C 型號適用) TCA-292MM

四 個 TekConnect 轉 接 頭 ( 僅 MSO/DPO73304DX 、
MSO/DPO72504DX 和 MSO/DPO72304DX 型號適用)

TCA-292D

一個 16 波道數位探棒含配件 (僅適用於 MSO5000 型號) P6616

每個波道一根被動探棒 (MSO5204、MSO5104、DPO5204 和
DPO5104)

TPP1000

每個波道一根被動探棒 (MSO5054、MSO5034、DPO5054 和
DPO5034)

TPP0500

觸控式螢幕觸控筆 (MSO5000 和 DPO5000) 119-6107-xx

NI SignalExpress 軟體 (MSO5000 和 DPO5000) 063-4253-xx

鍵盤 (僅 MSO/DPO70000C/DX 型號適用) 119-7083-xx

滑鼠 (光學) 119-7054-xx

DVI 至 VGA 轉接頭 (MSO70000C、DPO70000C 和 DPO7000C 系
列)

887–4187–00

前外蓋 (MSO5000 和 DPO5000)

所有其他的型號

200-5052-xx

200-4963-xx

腕帶 (僅 MSO/DPO70000C/DX 型號適用) 006-3415-05

配件包

MSO/DPO70000C/DX 型號

DPO7000C 型號

MSO5000 和 DPO5000 型號

016-1441-xx

016-1966-xx

016-2029-xx
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安裝儀器

配件 Tektronix 零件號碼

一個 17 通道數位探棒含配件套件 (僅 MSO70000DX 型號適用) P6717A

配件 Tektronix 零件編號

下列各項之一： MSO5000 和
DPO5000 型
號

DPO7000C
型號

MSO70000C-
/DX、 DPO70
000C/DX型號

北美 (選項 A0) 161-0348-00 161-0104-00 161-0213-00

歐洲通用 (選項 A1) 161-0343-00 161-0104-06 161-0209-00

英國 (選項 A2) 161-0344-00 161-0104-07 161-0210-00

澳洲 (選項 A3) 161-0346-00 161-0104-14 161-0211-01

北美地區 240 V (選項 A4) — 161-0104-08 —

瑞士 (選項 A5) 161-0347-00 161-0167-00 161-0212-00

日本 (選項 A6) 161-0342-00 161-A005-00 161-0213-00

中國 (選項 A10) 161-0341-00 161-0306-00 161-0352-00

印度 (選項 A11) 161-0349-00 161-0324-00 161-0325-00

巴西 (選項 A12) 161-0356-00 161-0356-00 161-0358-00

電源線

無電源線或交流轉接器 (選項 A99) — — —

操作需求
MSO/DPO70000DX、MSO/DPO70000C 和 DPO7000C

1. 將儀器放在儀器專用推車或測試
台上。儀器必須直立或置於後支
腳上。另提供選購的機架安裝套
件。請觀察下列空間需求和尺寸：

DPO7000C 型號： MSO/DPO70000C/DX 型號：

頂部： 0 英吋 (0 毫米) 0 英吋 (0 毫米)

左側和右側： 右側 0 英吋 (0 毫米)左側 3 英
吋 (76 毫米)

3 英吋 (76 毫米)

底部： 0 英吋 (0 毫米)支腳站立，支
架朝下

0 英吋 (0 毫米)支腳站立，支
架朝下

背面： 距離後支腳 0 英吋 (0 毫米) 距離後支腳 0 英吋 (0 毫米)

2. 寬度： 17.96 英吋 (456 毫米) 17.75 英吋 (451 毫米)

3. 高度： 10.9 英吋 (277 毫米) 11.48 英吋 (292 毫米)
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4. 請在操作儀器之前先 檢查環境溫
度：

5 ℃ 到 +45 ℃ (+41 ℉ 到
+113 ℉)。

5 ℃ 到 +45 ℃ (+41 ℉ 到
+113 ℉)。

5. 確認操作溼度： 在最高濕球溫度為 +29 ℃
(+84 ℉) 或 低 於 +45 ℃
(+113 ℉) 的非露點溫度下 相
對溼度須為 8% 到 80%

在 +45℃ (+113℉)時，最大限
制會遞減至 30% 相對溼度

最高溫度至 +32℃ (+90℉)的
相對溼度須為 8% 到 80%

5% 到 45% 相對溼度，溫度
超過 +32℃ (+90℉)、最高溫
達 +45℃ (+113℉)，非露點溫
度，而且必須符合最高濕球
溫度 +29.4℃ (+85℉) 範圍 (在
+45℃ (+113℉) 相對溼度會減
額到 32%)

6. 確認操作高度： DPO7000C 型號：3,000 公尺
(9,843 英呎)

MSO/DPO70000C/DX 型號：
3,000 公尺 (9,843 英呎)，海拔
高度超過 1500 公尺 (4921.25
英呎) 時，每升高 300 公尺
(984.25 英呎)，最大操作溫度
會降低 1 ℃。

7. 最大輸入電壓 (DPO7000C 型號)：

50 Ω

1 MΩ

5 VRMS，不允許脈衝，峰值 ≤ ±24 V。

150 V，超過 200 KHz 時，以每十倍頻率衰減 20 dB 到 9 VRMS。
介於中央導線到接地的最大 BNC 輸入電壓是 400 V 峰值。包
括直流之任意波形的 RMS 電壓限制為 <150 V。峰值超過 150
V 的脈衝，其最大脈衝寬度是 50 μs。範例：從 0 至 400 V 峰
值時，長方形波形，其工作係數是 14%。最大暫態耐受電壓
是 ± 800 V 峰值。

最大輸入電壓，4 GHz 至 20 GHz 的型
號：

50 Ω <1 Vrms 適用於 <1V/FS 設定，<5.5 Vrms 適用於 ≥1 V/FS 設定。

最大輸入電壓，> 20 GHz 的型號：

50 Ω ≤1.2 V/FS 設定：

±1.5 V 相對於終端偏壓 (最大 30 mA)。
±5 V 絕對最大輸入電壓。

>1.2 V/FS 設定：

25 ℃ 時為 10 V，45 ℃ 時衰減為 8.4 V (受限於衰減器)。

邏輯探棒的最大非破壞性輸入電壓
(MSO70000C/DX 系列)：

±15 V

小心。 為了確保適當冷卻效果，請保持儀器底部和兩側沒有任何阻礙物。
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安裝儀器

MSO5000 和 DPO5000
1. 將儀器放在儀器專用推車或測試

台上。儀器必須直立或置於後支
腳上。另提供選購的機架安裝套
件。請觀察下列空間需求和尺寸：

背面： 2 英吋 (50.8 毫米)

左側： 2 英吋 (50.8 毫米)

2. 寬度： 17.3 英吋 (439 毫米)

3. 高度： 9.2 英吋 (233 毫米) 包括支腳

10.7 英吋 (272 毫米) 包括垂直提把和支腳

4. 操作儀器前，請先確認環境溫度： 5 ℃ 到 +50 ℃ (+41 ℉ 到 +131 ℉)

5. 請確認操作濕度： 高： 40 ℃ 到 50 ℃ (104 ℉ 到 122 ℉)、10% 到 60% 相對濕度

低： 0 ℃ 到 40 ℃ (32 ℉ 到 104 ℉)、10% 到 90% 相對濕度

6. 請確認操作高度： 3,000 公尺 (9,843 英呎)

7. 最大輸入電壓：

50 Ω 輸入阻抗

1 MΩ 輸入阻抗

5 VRMS，峰值 ≤±20 V (DF ≤6.25%)。

300 VRMS、CAT II，BNC 峰值 ≤±425 V。

若為 <100 mV/格，則從 20 dB/decade、100 kHz 以上衰減為
30 VRMS、1 MHz，10 dB/decade、1 MHz 以上。

若為 ≥100 mV/格，則從 20 dB/decade、3 MHz 以上衰減為
30 VRMS、30 MHz，10 dB/decade、30 MHz以上。

邏輯探棒的最大非破壞性輸入電壓： ±42 V

小心。 為了確保適當冷卻效果，請清除儀器背後和左側的任何阻礙物。

預防 ESD

小心。 直接的靜電釋放會損壞儀器輸出。 若要瞭解如何避免該損壞，請閱讀以下資訊。
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安裝儀器

在處理任何電器設備時，您必須注意靜電釋放 (ESD) 相關問題。 雖然儀器本身的設計具有強大的 ESD
防護，但大量的靜電直接進入訊號輸出時仍有可能造成儀器的損壞。 若要避免儀器的損壞，請使用以
下的技巧來預防靜電釋放到儀器中。

1. 當連接和拔除 TekConnect 轉接器
的纜線時，請配戴接地的抗靜電
腕帶，以釋放您體內的靜電電壓。
儀器已基於此目的而提供前面板
連接。

2. 測試台上未連接的纜線會產生大
量的靜電。 在將纜線連接到儀器
之前，將纜線的中央導線快速接
地，或將 50 Ω終端連接到一端，
以將纜線連接到測試中的儀器或裝
置之前釋放所有纜線中的靜電。

開啟儀器電源
電源供應需求

訊號源電壓與頻率 功率消耗

MSO70000C/DX 和 DPO70000C/DX 系列：

100–240 VRMS ±10%、50–60 Hz或 115 VRMS ±10%、
400 Hz。CAT II

≦ 1100 VA

DPO7000C 系列：

100–240 VRMS ±10%、47–63 Hz或 115 VRMS ±10%、
400 Hz

最大值 550 瓦數

MSO5000 和 DPO5000 系列：

100–240 VRMS ±10% 50–60 Hz115 V 440 Hz 最大為 275 瓦
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安裝儀器

DPO7000C 系列

MSO/DPO70000DX 和 MSO/DPO70000C 系列

MSO5000 和 DPO5000 系列
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安裝儀器

關閉儀器電源

MSO/DPO70000DX、MSO/DPO70000C 和 DPO7000C 系列

MSO5000 和 DPO5000 系列
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安裝儀器

中斷電源

DPO7000C 系列

MSO/DPO70000DX 和 MSO/DPO70000C 系列

MSO5000 和 DPO5000 系列
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安裝儀器

保護示波器的安全
1. 請使用標準筆記型電腦安全鎖，

保護您座位上示波器的安全性。

MSO5000 和 DPO5000 系列

連接到網路
您可以將儀器連接到網路，進行列
印、檔案共享、網路存取和其他功
能。請先詢問網路管理員，再使用標
準 Windows 公用程式來設定儀器的網
路連線。

請使用Windows 的遠端桌面連線，並
從遠端控制和檢視儀器。
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安裝儀器

新增第二台顯示器
您可以一邊操作儀器，一邊在外部顯示器上使用 Windows 和已安裝的應用程式。請依照下列程序執
行，設定雙顯示器組態。

MSO/DPO70000DX 和 MSO/DPO70000C 系列

1. 關閉電源。

2. 連 接 第 二 台 監 視 器 。 如 果
MSO/DPO70000C 搭配 VGA 監視
器使用，請使用 DVI 至 VGA轉接
頭。

3. 連接鍵盤。

4. 連接滑鼠。

5. 開啟儀器電源。

6. 開啟監視器電源。

MSO/DPO70000DX 和 MSO/DPO70000C 系列
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安裝儀器

DPO7000C 型號

1. 關閉電源。

2. 連接第二台顯示器。

3. 連接鍵盤。

4. 連接滑鼠。

5. 開啟儀器電源。

6. 開啟顯示器電源。

DPO7000C 系列
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安裝儀器

MSO5000 和 DPO5000 型號
1. 關閉電源。

2. 連接第二台監視器。

3. 連接鍵盤。

4. 連接滑鼠。

5. 開啟儀器電源。

6. 開啟監視器電源。

MSO5000 和 DPO5000 型號
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安裝儀器

作業系統復原
如果您的儀器已隨附作業系統復原 DVD，而您需要復原作業系統，請使用 DVD 隨附的程序執行。

儀器的硬碟個別分割區含有作業系統復原檔案。

復原儀器作業系統的建議方式是使用硬碟復原檔案。

小心。 使用復原程序將硬碟重新格式化，然後重新安裝作業系統。 所有儲存的資料都會遺失。如果
可能，執行系統復原前，將重要檔案儲存至外部媒體。

1. 重新啟動儀器。在開機程序期間，您會在螢幕頂端看見下列訊息： Starting Acronis Loader... press
F5 for Acronis Startup Recovery Manager (正在啟動 Acronis Loader… 按下 F5 啟動 Acronis Startup Recovery
Manager)

注意。 若要成功完成系統復原，您必須使用 Windows 版本的 Acronis 軟體。 使用一般 MAC 鍵盤會啟
動 DOS 版本的 Acronis 軟體。 請勿使用 MAC 鍵盤。

2. 重複按下 F5 鍵，直到 Acronis True Image Tool 開啟為止。 從訊息出現至儀器進行儀器正常啟動為
止，總共 15 秒。如果儀器未開啟 Acronis 應用程式，將儀器的電源關閉，然後開啟電源再試一次。

3. 按一下「Restore」(復原)。

4. 在「Confirmation」(確認) 對話方塊中，按一下「Yes」(是) 復原儀器作業系統，或按一下「No」(否)
結束復原程序。復原程序大約進行 30 分鐘；實際時間須視儀器組態設定而定。

安裝 MSO5000 和 DPO5000 硬碟
小心。 將硬碟組件顛倒插入會損害
儀器。

1. 請確認儀器為關閉狀態。

2. 將硬碟組件底盤面朝上插入儀器。

3. 使用手轉螺絲固定硬碟組件。

4. 安裝外蓋。
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了解儀器

了解儀器

前面板
MSO/DPO70000DX、MSO/DPO70000C 和 DPO7000C

1. DVD/CD-RW 光碟機

2. 前面板控制項
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了解儀器

3. USB 埠

4. 接地端子

5. 復 原 的 資 料 輸 出 ( 不 適 用 於
DPO7104 和 DPO7054)

6. 復 原 的 時 脈 輸 出 ( 不 適 用 於
DPO7104 和 DPO7054)

7. 探棒補償輸出

8. 探棒校準輸出

9. 波道 1–4 輸入

10. 輔助觸發輸入

11. 快速邊緣輸出

12. 直流探棒校正輸出

13. 邏輯探棒輸入

14. 通過 1 MΩ 電阻器的接地端子

DPO7000C 系列

DPO70000C 系列

MSO70000C 系列

DPO70000DX 系列

MSO70000DX 系列
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了解儀器

MSO5000 和 DPO5000 系列
1. 前面板控制項

2. 接地端子

3. 探棒補償輸出

4. 輔助觸發輸入

5. 波道 1–4 輸入

6. 邏輯探棒輸入

7. USB 埠

MSO5000 和 DPO5000 系列

側面板和後面板
MSO/DPO70000DX 和 MSO/DPO70000C

1. 卸除式硬碟

2. 滑鼠專用 PS-2 接頭

3. USB 主要埠

4. 被動式 eSATA 埠

5. 連接網路的 RJ-45 LAN 接頭

6. TekLink 接頭

7. 連接控制器的 GPIB 埠

8. 喇叭的 Line Out 接頭

注意。 有些儀器可能有其他音效接
頭。

9. 連接麥克風的麥克風接頭

10. DVI-D 視訊埠

11. COM 1 和 COM 2 序列埠

12. 鍵盤專用 PS-2 接頭

13. 輔助輸出

14. 參考輸出

15. 外部參考輸入

16. VGA 埠

MSO/DPO70000DX 和 MSO/DPO70000C 系列
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了解儀器

DPO7000C

1. 鍵盤專用 PS-2 接頭

2. 滑鼠專用 PS-2 接頭

3. 連接網路的 RJ-45 LAN 接頭

4. 喇叭的 Line Out 接頭

5. 連接麥克風的麥克風接頭

6. USB 主要埠

7. DVI-1 視訊埠

8. COM 1 和 COM 2 序列埠

9. 印表機連線

10. 連接監視器的XGA輸出視訊埠 (僅
適用於示波器)

11. 卸除式硬碟

12. 連接控制器的 GPIB 埠

13. 輔助輸出

14. 通道 3 輸出

15. 外部參考輸入

DPO7000C 系列
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了解儀器

MSO5000 和 DPO5000
1. Line In 接頭

2. 喇叭的 Line Out 接頭

3. 連接麥克風的麥克風接頭

4. 連接監視器的視訊埠

5. 鍵盤專用 PS-2 接頭

6. 滑鼠專用 PS-2 接頭

7. USB 主要埠

8. 連接網路的 RJ-45 LAN 接頭

9. USB 裝置埠

10. 探棒電源輸入，使用 119-7465-xx
電源供應

11. 外部參考輸入

12. 輔助輸出

13. 安全鎖輸入

14. AC 電源輸入

15. 卸除式硬碟外蓋

16. 接地的連接

MSO5000 和 DPO5000 系列
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了解儀器

若要使用 PS-2 裝置，則必須在開啟儀器前將這些裝置插入。 請勿以熱插拔方式使用 PS-2 裝置。

介面和顯示
功能表列模式可用來存取控制本儀器所有功能和性能的指令。工具列模式可存取最常用的功能。

1. Menu Bar (功能表列)： 存取資料
輸入∕輸出 (I/O)、列印、線上說
明和儀器功能

2. Buttons/Menu (按鈕∕功能表)：按
一下便可切換工具列模式和功能
表列模式，以及自訂工具列

3. Multipurpose Knob Readouts (多用
途旋鈕讀值)：調整及顯示多用途
旋鈕控制的參數

4. Display (顯示)： 以游標呈現顯示
中的波形、參考波形、數學波形、
數位波形和匯流排波形

5. Waveform Handle (波形拖曳點)：
按一下並拖曳，便可變更波形或
匯流排的垂直位置。按一下拖曳
點，便可透過多功能旋鈕來變更
位置和刻度。

6. Controls Status (控制項狀態)： 對
應至垂直改變、刻度、偏移和參
數的快速參考

7. Readouts (讀值)： 顯示這個區域
中的游標和測量讀值。您可從功
能表列或工具列選取測量值。如
果出現控制視窗，表示某些讀值
組合會移到方格圖區域。

警告。 如果出現垂直剪裁，探棒頭則具有危險的電壓， 但讀數格只會顯示低電壓。如果 出現垂直
剪裁的情況，儀器讀數格則會出現符號。 發生訊號垂直裁剪的自動振幅相關測量值， 所產生的結果
將不精確。若儲存或匯出讓其他程式使用的波形被裁剪， 也會導致不精確的振幅值。如果是 裁剪數
學波形，則數學波形的振幅測量值並不會受到 影響。

8. Status (狀態)： 顯示擷取狀態、模式和擷取數目；觸發狀態、日期和時間；以及對應至記錄長度
和水平參數的快速參考
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了解儀器

1. Buttons/Menu (按鈕∕功能表)：按
一下便可切換工具列和功能表列，
以及自訂工具列

2. 拖曳游標，便可測量螢幕上的波
形

3. 拖曳位置圖示，便可重新定位波
形

4. 請按一下圖示以指定波形垂直位
置和刻度的多用途旋鈕

5. 將滑鼠游標拉過波形區域，便可
建立特定矩形來縮放、啟用∕停
用長條圖、範圍量測和新增及控
制視覺觸發區域

6. 拖曳圖示，便可變更觸發位準
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了解儀器

控制面板
MSO/DPO70000DX、MSO/DPO70000C 和 DPO7000C

1. 按下此按鈕，便可自動依選取波
道來設定垂直、水平和觸發控制
項。

2. 按下此按鈕，便可恢復到預設值。

3. 按下此按鈕，便可直接列印或儲
存螢幕擷取。

4. 按下此按鈕，便可啟動 MultiView
Zoom，並新增擴大方格圖到畫面
上。

5. 調整水平刻度、位置、延遲，以
及設定所有波形的記錄長度 (解析
度)。

6. 使用此按鈕來啟動和停止擷取、
啟動單一擷取程序、清除資料，
或啟動快擷取。

7. 使用此按鈕來設定觸發參數。按下
「Advanced」(進階)可顯示其他的
觸發功能。Arm (作用中)、Ready
(就緒) 和 Trig'd (已觸發) 燈號表示
擷取狀態。

8. 旋轉此旋鈕可調整波形強度。

9. 旋轉此旋鈕可調整從螢幕介面選
取的參數。按下此按鈕可切換一
般調整和微調。

10. 按下此按鈕可開啟和關閉游標。

11. 用於搜尋和標記波形。

12. 按下此按鈕可開啟和關閉觸控式
螢幕。

13. 開啟和關閉波道顯示。調整垂直
刻度、位置，或是偏移波形。切
換位置和偏移。

在MSO70000系列儀器上，請使用
「Digital > Digital Setup」(數位 >數
位設定) 功能表來開啟數位波道。
(請參閱頁45，設定數位訊號輸入)
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MSO5000 和 DPO5000

1. 旋轉此旋鈕可調整從螢幕介面選
取的參數。按下「Fine」(微調)以
選取微調，按下「Coarse」(粗調)
以選取粗調。

2. 按下此按鈕可開啟和關閉游標。

3. 按下此按鈕可使用多用途旋鈕調
整波形強度。

4. 按下此按鈕，便可啟動 MultiView
Zoom，並新增擴大方格圖到畫面
上。

5. 按下此按鈕，可執行自動測量、
搜尋符合使用者定義事件∕條件
的擷取結果，或是啟動或停止快
速擷取。

6. 調整水平刻度、位置，以及設定
所有波形的水平和擷取參數。

7. 旋轉內縮放旋鈕，可控制縮放係
數。 旋轉外飛梭旋鈕，可以捲動
整個擷取波形的縮放視窗。 按下
播放-暫停按鈕，可以啟用或停止
波形的自動飛梭 (左右移動)。使用
飛梭旋鈕，可控制速度和方向。

8. 使用此按鈕來開始與停止擷取或
開啟單一擷取序列。

9. 使用此按鈕來搜尋和標記波形、
建立或刪除波形標記，或者跳到
上一個或下一個波形標記。

10. 按下此按鈕，便可自動依所選波
道來設定垂直、水平和觸發控制
項。

11. 使用此按鈕來設定觸發參數。按
下「Menu」(功能表) 可顯示其他
的觸發功能。
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12. 開啟和關閉通道顯示。 調整波形
的垂直刻度或位置。

在 MSO5000 系列儀器上，請按下
「D15–D0」按鈕，或使用「Dig-
ital > Digital Setup」(數位 > 數位設
定) 功能表來開啟數位波道。 ( 請
參閱頁45，設定數位訊號輸入)

13. 按下此按鈕可開啟和關閉觸控式
螢幕。

14. 按下此按鈕，可顯示數學、參考、
匯流排或垂直設定功能表。

15. 按下此按鈕，可關閉顯示的功能
表。

16. 按下此按鈕，可存取數位設定功
能表 (僅 MSO5000 系列)。

17. 按下此按鈕，可清除資料。

18. 按下此按鈕，便可將設定恢復到
預設值。

19. 按下此按鈕，可儲存並叫出設定、
波形與螢幕畫面。

20. 按下此按鈕，便可直接列印或儲
存螢幕擷取。
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存取線上說明
線上說明將深入提供本儀器所有功能的詳細資訊。

如果要從作用中視窗存取即時線上
說明，請選取「Help > Help on Win-
dow...」(說明> 視窗上顯示說明...)，
或是按下 F1。

1. 如果要存取說明系統中的任何主
題，請選取「Help > Contents and
Index....」(說明 > 內容和索引...)。

2. 使用「內容」、「索引」、「搜
尋」或「我的最愛」等索引標籤來
選取主題，然後按一下「Display」
(顯示)。

如果要瀏覽說明系統，您可以：

按下說明視窗的按鈕，在「概要」
和特定主題之間瀏覽。

按一下說明視窗中的「Minimize」
(最小化) 按鈕可將說明最小化，
以便您操作儀器。

同時按下Alt 和 Tab 可再查看上一
次的說明主題。
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存取功能表和控制視窗
您可以使用下列技巧來存取功能表和控制視窗：

按一下功能表，接著選取一個指
令。

在方格圖任何位置或在物件上按
滑鼠右鍵，便可使用捷徑功能表。
捷徑功能表可以即時線上顯示，
而且會依滑鼠右鍵按下的不同區
域位置或物件提供不同選項。右
圖舉出一些範例。

使用工具列模式時，按一下按鈕
可快速存取設定控制視窗。 (請參
閱頁19)
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檢查儀器
使用下列程序來驗證儀器的功能。

驗證內部診斷通過
1. 開啟儀器電源。

2. 選取「Instrument Diagnostics...」(儀
器診斷...)。

3. 按一下「Run」 (執行)。測試結果
會出現在診斷控制視窗。

4. 請驗證所有測試皆已通過。如果
發生診斷失敗情形，請連絡您當
地的 Tektronix 服務人員。
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擷取
本節將介紹使用擷取系統的概念和程序。

訊號路徑補償
如果自上次訊號路徑補償 (SPC) 至今溫差超過 5 ℃ (9 ℉)，請使用這項程序。請定期執行訊號路徑補
償，以確保您的測量值可達到最高的精確度。當您使用示波器以較高靈敏度 (10 mV/格和較低) 設定來
測量訊號，而不論溫度變化或上次執行距今的時間時，Tektronix 認為是執行 SPC 的最佳時機。若未定
期執行這項程序，可能會導致儀器無法達到保證的效能等級。

1. 必要條件：儀器需開機 20分鐘，
且所有輸入訊息皆已移除。

2. 選取「Instrument Calibration」 (儀
器校準)。

3. 當溫度狀態變成「Ready」(就緒)
時，請按一下「Run SPC」(執行
SPC) 以啟動校準。校準程序可能
需要 10 到 15 分鐘。
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4. 如果儀器沒有通過，請重新校準
儀器，或是交由合格服務人員維
修。

注意。 若要在超過一個月未執行SPC
時顯示 SPC狀態圖示或顯示警告，請
按一下對應的核取方塊。

5. 如果需要 SPC 的圖示為紅色時，
請執行訊號路徑補償。
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設定類比訊號輸入
使用前面板按鈕，可設定儀器進行訊號擷取。

1. 將探棒連接到輸入訊號源。

小心。 若要避免造成儀器的損壞，在進行儀器的連接時請一律配戴接地的抗靜電腕帶，並觀察輸入
接頭的最大輸入電壓功率。

MSO/DPO70000DX 和 MSO/DPO70000C 系列 DPO7000C 系列

MSO5000 和 DPO5000 系列

2. 按下前面板按鈕來開啟和關閉波道，以便選取輸入波道。

MSO5000 和 DPO5000 系列

MSO/DPO70000DX、MSO/DPO70000C 和 DPO7000C 系列
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3. 按下 「Autoset」(自動設定)。

4. 使用前面板旋鈕調整垂直位置、刻度和偏移。

MSO5000 和 DPO5000 系列 MSO/DPO70000DX、MSO/DPO70000C 和 DPO7000C 系列

5. 使用前面板旋鈕調整水平位置和刻度。

水平位置會決定前置觸發和後置觸發的取樣數目。

MSO5000 和 DPO5000 系列 MSO/DPO70000DX、MSO/DPO70000C 和 DPO7000C 系列
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使用預設值設定
1. 如果要快速恢復到原廠預設值設定，請按下

「DEFAULT SETUP」 (預設設定)。

MSO/DPO70000DX、MSO/DPO70000C和 DPO7000C系列

MSO5000 和 DPO5000 系列
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使用自動設定
使用自動設定 (Autoset) 功能，便可快速並自動依據輸入訊號特性來設定儀器 (擷取、水平、觸發和垂
直)。 自動設定可調整訊號，使波形靠近中間水平觸發來顯示 2 或 3 個週期。

1. 請接上探棒，再選取輸入波道。
(請參閱頁29，設定類比訊號輸入)

2. 按下「AUTOSET」 (自動設定)按
鈕執行自動設定功能。

MSO/DPO70000DX、MSO/DPO70000C 和 DPO7000C 系列

MSO5000 和 DPO5000 系列

3. 按一下「Undo」(復原) 以取消上
一次的自動設定。不受「自動設
定」影響的參數仍會保留其設定。

快速秘訣
「Autoset」(自動設定) 可自動設定類比波道。

在含有 iCapture 的儀器上，「Autoset」(自動設定) 可自動設定 iCapture 波道。

為了適當調整波形位置，您可能會用 Autoset (自動設定) 來改變垂直位置。Autoset (自動設定) 也可
調整垂直偏移。
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顯示一個以上的波道時，如果您使用 Autoset (自動設定)，本儀器就會選取最小編號的波道執行水
平比例和觸發。您可以分別控制各個波道的垂直刻度。

如果在螢幕沒有顯示任何波道時使用 Autoset (自動設定)，儀器就會啟動波道 1 (Ch 1)，並設定波道
刻度。

按一下 X 便可關閉 Autoset Undo (復原自動設定) 控制視窗。Autoset Undo (復原自動設定) 關閉後，
您仍然可以從 Edit (編輯) 功能表選取 Undo Last Autoset (復原上一次自動設定) 來恢復成上一次的自
動設定。

您可以在 Utilities (公用程式) 功能表變更 User Preferences (使用者偏好)，設定 Autoset Undo (復原自動
設定) 控制視窗不要自動開啟。

探棒補償和偏移校正
請參閱儀器線上說明執行下列程序，以最佳化測量精確度：

補償被動探棒

Compensate active probes

偏移校正輸入波道

擷取概念
擷取硬體
顯示訊號之前，訊號會先通過輸入波道，以設定刻度和完成數位化。每個波道都有專用的輸入放大器
和數位器。每個波道都會產生數位資料流，讓儀器從中擷取波形記錄。

取樣過程

擷取是指取樣類比訊號、將其轉換成
數位資料、組合成波形記錄，接著波
形記錄再儲存到擷取記憶體的過程。

即時取樣

使用即時取樣時，儀器會數位化所有
單一觸發事件擷取到的點。使用即時
取樣可以擷取單擊訊號或暫態訊號。
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內插即時取樣

使用內插即時取樣時，儀器將數位化
所有單一觸發事件擷取到的點。如果
儀器無法透過最大即時取樣率擷取建
立完整波形的足夠取樣數，它就會採
取內插方式。使用內插即時取樣可以
擷取單擊訊號或暫態事件。

等時取樣

本儀器會使用等時取樣，將取樣率
擴展超過其即時最大取樣率。只有當
Equivalent Time (等時) 已選取，而且
即時取樣之時基已設定成取樣率快到
無法建立波形記錄的情況下，您才能
使用等時取樣功能。

本儀器會多次擷取重複性波形，以便
取得完整波形記錄在建立時所需的取
樣密度。可想而知，等時取樣功能只
可用於重複性訊號。

波形記錄

本儀器將以下列參數來建立波形記
錄：

取樣間隔：取樣點之間的時間。

記錄長度：波形記錄構成時所需
要的取樣數量。

觸發點：波形記錄中的零時間參
考點。

水平位置：在關閉水平延遲時，
水平位置表示波形記錄百分比例
(介於 0% 到 99.9%)。觸發點和水
平參考在波形記錄中將顯示相同
時間。例如，當水平位置為 50%
時，觸發點就是位在波形記錄的
中間。如果有啟用水平延遲，從
觸發點到水平參考之間的時間就
是水平延遲時間。
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內插法
當儀器沒有取得建立波形記錄所需之全部實際取樣時，儀器可以在擷取的取樣間採用內插法。線性內
插法會應用最適直線，計算出介於實際擷取取樣之間的記錄點。

Sin(x)/x 內插法會應用最佳曲線，計算出介於實際擷取數值之間的記錄點。Sin(x)/x 內插法為預設的內
插模式。因為它在準確呈現波形時所需的實際取樣點數比線性內插法少。

擷取模式的運作方式
Sample (取樣) 模式會保留從每個擷取
間隔的第一個取樣點。「取樣」是預
設模式。

Peak Detect (峰值檢) 模式會使用兩個
連續擷取間隔所含全部樣本中最高和
最低者。這個模式只能用於即時、沒
有任何插入的取樣，而且可以用來擷
取高頻率突波。

Hi Res (高解析度) 模式對所有擷取間
格計算其平均取樣值。「高解析度」
模式提供較高解析度、較窄頻寬的波
形。

Envelope (包封) 模式會從眾多擷取中
找出最高和最低的記錄點。「包封」
模式會為每次擷取使用「峰值檢測」
模式。

Average (平均)模式會計算眾多擷取上
每個記錄點的平均值。「平均」模式
會為每個擷取使用「取樣」模式。請
使用平均模式來降低隨機雜訊。

Waveform Database (波形資料庫) 模式
是經過數次擷取後所得到的來源波
形資料三維累積。除了振幅和時序資
訊，這個資料庫還會包括所擷取特定
波形點 (時間和振幅) 的次數計數。
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改變擷取模式
請使用此程序來改變擷取模式。

1. 選 取 「 Horiz/Acq > Acquisition
Mode」( 水平/擷取＞擷取模式)。

2. 請執行下列一項動作來選取擷取
模式：

直接從功能表選取擷取模式。

按一下 「Mode...」(模式...) 選
取擷取模式。

3. 使用Average (平均)或 Envelope (包
封) 擷取模式時，請按一下 「# of
Wfms」 (波形數目) 控制項，然後
以多用途旋鈕設定波形數目。使
用 WfmDB (波形資料庫) 模式時，
請按一下 「Samples」(取樣) 控制
項，然後以多用途旋鈕設定取樣
數目。

快速秘訣
按一下數字鍵盤圖示，便可設定波形或取樣的數目。
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開始和停止擷取
在選取要擷取的波道之後，請使用下列程序。

1. 請按下前面板的「RUN/STOP」(運
行∕停止)按鈕，開始進行擷取。

2. 再按一次「RUN/STOP」(運行∕停
止) 按鈕，便可停止擷取。

3. 如果要進行單一擷取，請按下
「Single」(單一) 按鈕。 MSO/DPO70000DX、MSO/DPO70000C 和 DPO7000C 系列

MSO5000 和 DPO5000 系列

選取水平模式
您的儀器有三個水平模式。「自動」是預設模式。請選取最適合測試設定的水平模式。

若 要 設 定 水 平 模 式 ， 請 選 取
「 Horiz/Acq > Horizontal/Acquisition
Setup」(水平/擷取 >水平/擷取設定)，
顯示水平控制視窗。選擇下述模式
之一。

在「自動」模式可以設定「刻度」和
「取樣率」。記錄長度是相依變數。
若變更刻度會讓記錄長度超出「記錄
長度限制」，取樣率會減少至下一個
可用設定。

取樣模式若為即時且取樣率到達即時
限制，便無法增加取樣率。
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若要設定「記錄長度限制」，請按
一下 「Record Length Limit」(記錄長
度限制)，並使用按鈕或鍵盤設定限
制。預設的最大限制取決於儀器型號
和記錄長度選項。

在「常態取樣率」模式可以設定「取
樣率「和「刻度」。預設取樣率可以
確保頻寬濾波器作業。記錄長度是相
依變數。最大記錄長度取決於儀器型
號和記錄長度選項。

前面版解析度旋鈕可以在自動和常態
取樣率模式下變更取樣率。
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在「手動」模式下可以設定「取樣
率」和「記錄長度」。根據取樣率和
記錄長度計算出來的「水平刻度」是
相依變數。

「水平刻度」旋鈕可以變更手動模式
的記錄長度。

如圖所示，這三個模式與取樣率、刻
度和記錄長度均有所互動。水平線是
最大即時取樣率。每個樓階顯示若將
刻度增加到最大記錄長度或記錄長度
限制，就必須減少取樣率。手動模式
使用最大記錄長度。

「自動」和「常態取樣率」模式是相
同的。但「常態取樣率」模式讓取樣
率維持在可以使用加強型頻寬濾波器
的常態取樣率。

快速秘訣
數位取樣率和解析度為相依變數，並由類比取樣率選項所控制。
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使用 FastAcq
快速擷取模式可減少波形擷取之間的停工時間，以便擷取並顯示暫態訊號 (如突波或矮波脈衝)。快速
擷取模式也可反應發生率之強度來顯示波形狀態。

1. 按下 「FastAcq」 (快速擷取)。

MSO/DPO70000DX、MSO/DPO70000C 和 DPO7000C 系列

MSO5000 和 DPO5000 系列

2. 尋找突波、暫態訊號或其他隨機
突波。

當您注意到異常狀況時，請設定觸
發系統來尋找它。(請參閱頁160，
捕捉間歇性異常)

快速秘訣
數位波道和匯流排不適用於 FastAcq 模式。

若要讓擷取明細或罕見事件達到最佳化，請選取「Horiz/Acq > Horizontal/Acquisition Setup > Acquisition
> Fast Acq」(水平/擷取 >水平/擷取設定 > 擷取 > 快速擷取)，並在「Capturing Details」(擷取明細)或
「Capturing rare events」(擷取罕見事件) 選取「Optimize」(最佳化)。
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使用 DSP 加強型頻寬
如果儀器擁有加強型頻寬功能，您便可使用 DSP (數位訊號處理) 加強型頻寬進行更精確的上升時間測
量，以便擴充頻寬及拉平高取樣率時的帶通頻率。「加強型頻寬」可讓啟用的波道產生配比響應，供
您執行波道至波道比較及不同測量。

1. 按下 「AUTOSET」(自動設定) 來
設定水平、垂直和觸發控制項，
或是手動設定控制項。

MSO/DPO70000DX、MSO/DPO70000C 和 DPO7000C 系列

MSO5000 和 DPO5000 系列

2. 選取 「Vertical > Bandwidth En-
hanced...」(垂直>加強型頻寬...)。
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3. 按一下 「Digital Filters (DSP) En-
abled」(啟用數位濾波器 (DSP))，
開啟加強型頻寬。必須設定正確
的取樣率，才能啟用 DSP。

4. 若要強制執行可啟用 DSP 濾波
器的常態取樣率，請勾選 「Force
Constant Sample Rate」(強制常態取
樣率)。

注意。 若尚未設定，請選取「常態
取樣率」，將水平模式設定為常態取
樣率、將取樣率設定為允許 DSP，並
選取 DSP 頻寬。

5. 從 「Bandwidth」(頻寬) 清單中選
取所需要的頻寬。

可用的頻寬選項取決於儀器、探
棒和探棒頭。

選取「Analog Only」(僅類比)，選
取硬體頻寬。

6. 若要將這些選擇套用到所有波道，
請勾選 「Apply To All Channels」
(套用到所有波道)。

如果探棒不同，儀器則無法將所
有波道設定成相同，但儀器會為
每個波道設定最接近的可能頻寬
值。

當加強型頻寬啟動時，頻寬指示
器將顯示於垂直讀數中。

快速秘訣
在波形拖曳點上按一下滑鼠右鍵叫出功能表，選取波道頻寬和其他加強型頻寬設定。

此 DSP 加強型頻寬可在最大取樣率時執行。

請在訊號上升時間小於 50 ps 時使用 DSP 加強型頻寬。

如果要產生較多波形輸送量、過激訊號，或是您偏好使用自訂的DSP 後置處理時，請選取「Analog
Only」(僅類比)。

若要限制儀器頻寬，請選取 「Vertical > Bandwidth Limit」(垂直 > 頻寬限制)，再選取頻寬。
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設定終端電壓
僅 MSO/DPO70000DX 型號提供終端電壓調整功能。

示波器輸入通常終止於接地端。 進行測量的訊號通常都不是接地參考。 將訊號接地會降低測量結果
的正確性，或者可能會損害 DUT。

儀器會傳送各種不同的終端電壓至測試中裝置 (DUT)，最高可達 ±3.4 伏特，並支援大的偏移範圍。 此
功能可讓您調整示波器以鏡像 DUT 的條件和行為，並在類似的操作環境中測量高速訊號。

使用終端電壓和偏移的組合將 DUT 操作範圍中的示波器參考點置中，可得到最大的可用動態範圍並
將測量系統的雜訊降到最低。

若要設定波道的終端電壓，請執行下列步驟：

1. 選取「Vertical > Vertical Setup」(垂
直 > 垂直設定)。

2. 按一下「Termination Voltage」(終
端電壓)欄位。使用鍵盤或多功能
旋鈕設定終端電壓。
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使用捲動模式
Roll (捲動) 模式將顯示類似低頻訊號的紙條圖表記錄器之畫面。捲動模式會直接顯示已擷取的資料
點，而不用等候擷取到完整的波形記錄。

1. 選取 Horiz/Acq > Horizontal/Acquisi-
tion Setup...( 水平/擷取>水平/擷取
設定...)。

2. 如果沒有選取的話，請按一下
「Acquisition」(擷取)索引標籤。
按一下 「Auto」(自動)便可開啟
Roll (捲動) 模式。

注意。 Roll (捲動) 模式需要配合
Sample (取樣)、Peak Detect (峰值檢測)
或 Hi Res (高解析度) 等擷取模式。

3. 如果要在 Roll (捲動) 模式停止擷
取：

如果不是使用 Single Sequence
( 單次程序 ) 模式，請按下
「RUN/STOP」(運行∕停止)來
停止 Roll (捲動) 模式。

如果是使用 Single Sequence (單
次程序)模式，Roll (捲動)模式
擷取會在擷取到完整記錄時自
動停止。

MSO/DPO70000DX、MSO/DPO70000C 和 DPO7000C 系列

MSO5000 和 DPO5000 系列

快速秘訣
切換至 Envelope (包封)、Average (平均)或WfmDB (波形資料庫)擷取模式將會關閉Roll (捲動)模式。

如果水平刻度設定為 50 ms/div 或更快時，Roll (捲動) 模式將會停用。
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設定數位訊號輸入
使用「Digital Setup」(數位設定) 功能表來設定數位通道以擷取訊號。僅 MSO70000C/DX 和 MSO5000 系
列儀器、已安裝選項 MSOE 的 DPO5000 系列儀器，及已安裝選項 MSOU 的 DPO70000DX 儀器才可使用
數位通道。

1. 將邏輯探棒連接到儀器。

2. 將探棒連接到輸入訊號源。

小心。 若要避免造成儀器的損壞，
在進行儀器的連接時請一律配戴抗靜
電腕帶，並觀察輸入接頭的最大輸入
電壓功率。

MSO70000C/DX 和 DPO70000DX 系列

MSO5000 和 DPO5000 系列

3. 使用「Digital」(數位) 功能表設定
數位波道和匯流排。

( 請參閱頁46，設定數位波道) 和 ( 請
參閱頁47，設定匯流排)
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設定數位波道
您可以在 MSO70000C/DX 和 MSO5000 系列儀器、已安裝選項 MSOE 的 DPO5000 系列儀器及已安裝選
項 MSOU 的 DPO70000DX 儀器上，設定數位通道臨界值、大小、位置和標籤。

1. 選取「Digital > Digital Setup」(數位
> 數位設定)。

2. 為您要設定的數位波道選取「D7
- D0」或「D15 - D8」索引標籤。

3. 按一下「Digital channel」(數位波
道)按鈕以開啟或關閉數位波道畫
面。

4. 按一下「Threshold」(臨界值) 或
「Position」(位置) 並使用鍵盤或
多功能旋鈕進行調整。或者，輸
入全域臨界值並按一下「Apply」
(套用) 來設定所有 16 個波道的臨
界值。
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5. 若要變更所有數位波道所顯示的
垂直大小，請按一下「Size」(大
小) 並從清單中選取顯示大小。

6. 若要變更數位波道標籤，請按一下
標籤並使用鍵盤以輸入新標籤。

設定匯流排
您可以設定串列 (選購) 和並列匯流排。

1. 選取「Vertical > Bus Setup」(垂直 >
匯流排設定)，或在某些儀器上，
選取「Digital > Bus Setup」(數位 >
匯流排設定)。

2. 選取「Config」(設定) 索引標籤。
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3. 捲動然後選取要設定的匯流排。

4. 若要開啟或關閉匯流排的畫面，
請按一下「Bus」(匯流排) 按鈕。

5. 若要變更匯流排的預設標籤，請
按一下「Label」(標籤) 並使用鍵
盤來輸入新標籤。

6. 若要變更顯示的匯流排位置，請
按一下「Bus Position」(匯流排位
置)並使用鍵盤或多功能旋鈕來輸
入新的匯流排位置。

7. 若要選取匯流排類型，請按一
下「Bus Type」(匯流排類型) 的
「Serial」(串列) 或「Parallel」(並
列)。

您可以設定每個匯流排類型。

( 請參閱頁48，設定串列匯流排) 或
( 請參閱頁49，設定並列匯流排)

快速秘訣
您可以按一下匯流排或波形拖曳點，並將拖曳點拖曳到所需的位置，來設定匯流排或波形的位置。

設定串列匯流排
您可以設定串列 (選購) 匯流排參數。 您僅可以在 MSO 系列儀器上的匯流排定義中使用數位波道。

1. 若要設定串列匯流排，請選取
「Bus Type」(匯流排類型)的「Se-
rial」(串列) ，並從下拉式清單中
選取串列匯流排類型。
每個匯流排類型都擁有您設定的
專屬參數集合。 為選取的匯流排
設定其他適當的匯流排類型。

請參閱線上說明，以取得設定匯流排
的詳細說明。

2. 若要為顯示的匯流排元件選取輸
入，請按一下「Component」(元件)
的「Input」(輸入)並從顯示的清單
中選取。
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3. 若要設定輸入臨界值，請按兩下
「Threshold」(臨界值)並使用鍵盤
輸入臨界值。

注意。 若要個別設定目前為共用的臨
界值時，請移至「Trig > A Event (Main)
Trigger Setup」(觸發 > A 事件 (主要)
觸發設定)，並將「Settings」(設定)變
更成「Independent」(獨立)。

4. 若要為顯示的匯流排元件選取極
性，請按一下「Component」(元件)
的「Polarity」(極性)並從顯示的清
單中選取。

快速秘訣
若要使用自訂串列解碼器，請參閱線上說明。

設定並列匯流排
您可以設定並列匯流排參數。 您僅可以在 MSO 系列儀器上的匯流排定義中使用數位波道。
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1. 若要設定並列匯流排，請選取
「Bus Type」(匯流排類型)的「Par-
allel」(並列)。

請參閱線上說明，以取得設定匯
流排的詳細說明。

2. 若要將來源新增到匯流排。請按
一下「Add Sources」(新增來源) 的
「Select」(選取) 按鈕。

3. 按一下每個您要於匯流排中使用的
波道按鈕。並列匯流排的順序是由
您選取波道的順序所決定的。 僅
可在 MSO 系列儀器上將數位波道
作為來源使用。

4. 按一下「OK」(確定) 按鈕。
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5. 若要移動匯流排中的波道，請捲
動到您要移動的波道並選取該波
道，然後按一下向上或向下箭頭
按鈕。

6. 若要移除匯流排中的波道，請捲
動到您要移除的波道並選取該波
道，然後按一下「Remove」(移除)
按鈕。

7. 若要設定波道臨界值，請按一下
「Thresholds」(臨界值)的「Setup」
(設定) 按鈕。

8. 針對您要設定的每個臨界值按兩
下波道的「Threshold」(臨界值)，
並使用鍵盤或多功能旋鈕輸入臨
界值。

9. 設定所需的臨界值之後，按一下
「OK」(確定) 按鈕。

10. 若要將所有的波道設定為相同的
臨界值，請按兩下「Digital Thresh-
old」(數字門)並使用鍵盤輸入臨界
值。然後按一下「Apply」(套用)。

11. 在MSO70000C/DX儀器上，若要設
定時脈來源和極性，按兩下該項目
並從顯示的清單中選取。若要設定
時脈位準，按兩下「Clock Level」
(時脈位準)，然後使用鍵盤或多功
能旋鈕輸入位準。

設定匯流排畫面
您可以設定匯流排樣式和解碼。 您僅可以在 MSO 系列儀器上的匯流排定義中使用數位波道。
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1. 選取「Digital > Bus Setup」(數位 >
匯流排設定)。

2. 選取「Display」(顯示)索引標籤。

3. 若要選取匯流排，請捲動以顯示
匯流排，然後選取該匯流排。

4. 從匯流排解碼清單中選取解碼。

5. 如果要使用符號表格，請勾選
「Use Symbol File」(使用符號檔
案)。按一下「Browse」(瀏覽) 並
找到符號表格檔案。

部分匯流排有其他可供使用的設
定。 為您的匯流排設定適合的其
他設定。

請參閱線上說明，以取得設定匯
流排的詳細說明。
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開啟 MagniVu 的時間和原因
若為 MSO5000 系列，MagniVu 提供您較高解析度，以精確地放置邊緣。這可協助您在數位邊緣上，執
行精確的時序測量。所看到的細部，是一般數位波道取樣的 32 倍。

無論是執行中或已停止，隨時可以和主要數位擷取並列擷取 MagniVu 記錄。MagniVu 以集中在觸發周
圍的 10,000 點 60.6 ps 的最大解析度，提供取樣資料的高解析度檢視畫面。

注意。 MagniVu 本身集中在觸發點的周圍。使用大幅記錄長度查看非觸發點時，如果開啟 MagniVu，
數位訊號可能在螢幕之外。在這種情況下，通常您可以左右移動上方概要，尋找數位訊號的數位記錄。

使用 MagniVu
1. 按下 D15 – D0。

2. 選取「Digital > MagniVu」(數位 >
MagniVu)以將MagniVu切換至「On」
(開啟)。

快速秘訣
如果需要更多時序解析度，可開啟 MagniVu，增加解析度。

每次都會擷取MagniVu。如果示波器已經停止，開啟MagniVu 時仍能取得解析度，不必重新擷取。
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檢視數位波形的類比特性
iCapture 可讓您檢視數位通道訊號的類比特性。當您檢視波形的類比特性時，可使用額外的量測功能。
MSO70000C/DX 系列儀器和已安裝 MSOU 的 DPO70000DX 儀器可使用 iCapture。

1. 選取「Vertical > Vertical Setup」(垂
直 > 垂直設定)。

2. 按下「Digital input」(數位輸入)的
「iCapture」按鈕。

3. 按一下「Digital Source」(數位來
源)並選取要透過類比輸入傳送的
數位波道。
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4. 若要在將類比波形轉換至數位
格式以納入匯流排時，設定使用
的波道臨界值，請按一下「Logic
Properties」(邏輯內容) 按鈕。

5. 若要選擇要共用臨界值設定或
擁有獨立臨界值設定，請按一下
「Channel Settings」(波道設定) 並
從清單中選取「Shared」(共用) 或
「Independent」(獨立)。

6. 針對您要設定的每個臨界值，按
一下波道臨界值。使用鍵盤或多
功能旋鈕設定臨界值。

7. 設定所需的臨界值之後，按一下
「OK」(確定) 按鈕。

快速秘訣。
如果在 MSO70000DX 上使用 iCapture，您可以選取數位來源做為觸發訊號。MSO70000C 會在類比通
道上持續觸發，即使該通道已選作 iCaputure 的數位通道。

使用快速圖框模式
「快速圖框擷取」可在大筆記錄中將眾多觸發事件一筆一筆地擷取，並在之後分別檢視和測量每筆記
錄。Time Stamps (時間註記) 可以顯示特定圖框的絕對觸發時間，以及 2 個特定圖框觸發之間的相對時
間。
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1. 按下 「AUTOSET」(自動設定) 以
設定水平、垂直與觸發控制項目，
或以手動方式設定這些控制項目。

MSO/DPO70000DX、MSO/DPO70000C 和 DPO7000C 系列

MSO5000 和 DPO5000 系列

2. 選 取 Horiz/Acq > FastFrame
Setup...( 水平∕擷取>快速圖框設
定...)。
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3. 按一下「FastFrame」(快速圖框)，
以將其切換為「On」(開啟)。

4. 選取「Frame Size」(圖框尺寸) 與
「# of Events Frames」(事件圖框的
數目)。接著使用多用途旋鈕來設
定每一筆記錄。圖框數目代表擷
取之觸發事件的數目。 圖框尺寸
代表每次觸發事件 (或圖框) 所要
儲存的取樣數目。如果記憶體不
夠儲存所有記錄，圖框數目就會
減少。圖框長度越短，可擷取的
圖框數目就越多。

5. 使用 Frame Viewing (圖框檢視) 控
制項來選取要檢視的圖框。

6. 如果要檢視互相重疊的多個圖框，
請選取 「Overlay」(重疊)。

7. 使用 Time Stamps (時序註記) 控制
項來選取參考圖框的來源和圖框
數目。參考圖框是指測量二個圖框
之間相對時間所使用的起始點。

快速秘訣
數位波道和匯流排不適用於 FastFrame 模式。

當您要保留每次觸發事件的相關資料以供日後分析或目視檢驗時，請使用 FastFrame (快速圖框) 功
能。

當您想要擷取長停工時間中不特定的多個事件， 請使用快速圖框功能。
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檢視多層圖框時最好是使用 Normal (一般)、Green (綠色) 或 Gray (灰色)調色盤。因為使用 Temp (溫
度) 或 Spectral (頻譜) 時，所選取的深藍色圖框可能不易辨識。

如果您選取「Average Summary Frame」(平均摘要圖框)，即可將數學功能 (計算平均值) 設定為套用
至「All Frames」(所有圖框)，或是僅將該功能套用至摘要圖框。如果您主要是要想觀察摘要資料，
則選取「Summary Frame Only」(僅摘要圖框) 可以大幅提升系統輸送量。
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擷取

使用 FastFrame (快速圖框) 圖框搜尋工具
圖框搜尋工具能讓您找到 與其他圖框不同的 FastFrame (快速圖框)。

1. 選取 FastFrame (快速圖框) 圖框的
來源。

2. 輸入 From Frame # (起始圖框編號)
和 To Frame # (結束圖框編號) 以
設定「搜尋範圍」。

3. 按下 「Run/Stop」(運行/停止) 以
停止擷取。

MSO/DPO70000DX、MSO/DPO70000C 和 DPO7000C 系列

MSO5000 和 DPO5000 系列

4. 按下 「Start」(啟動) 以 開始搜
尋。

MSO/DPO70000DX、MSO/DPO70000C、DPO7000C 和 MSO/DPO5000 系列使用者手冊 59



擷取

「圖框搜尋工具」能搜尋 並顯示不
同圖框。

5. 如果您所尋找的異常不在顯示的
圖框中，按下 「No」(否)。「圖
框搜尋工具」能搜尋 另一個不同
的圖框。

6. 如果您所尋找的異常在顯示的 圖
框中，按下 「Yes」(是)。

7. 如果您完成搜尋，則按下「Stop」
(停止)。

8. 按下 「Run/Stop」(運行/停止) 以
重新開始 擷取。
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MSO5000 和 DPO5000 系列
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Pinpoint 觸發
Pinpoint 觸發系統提供了 A 和 B 觸發都可應用的進階觸發方式。如果 B 事件沒有在特定事件數或特定
時間之後觸發，它可重置觸發程序。Pinpoint 觸發可依據最複雜的觸發事件或觸發事件程序來支援擷
取事件。
MSO5000 和 DPO5000 儀器上僅可使用一部分的 Pinpoint 觸發功能。

本節將介紹使用此觸發系統的概念和程序。

觸發概念
觸發事件
觸發事件會建立波形記錄中的時序零點。所有的波形記錄資料皆依時序零點的時間來定位。本儀器會
持續擷取並保留足夠的取樣點，來填滿波形記錄的前置觸發部份。當觸發事件一出現，儀器就會開始
擷取取樣，建立波形記錄的後置部份 (也就是在觸發事件之後、或其右邊的顯示部份)。一旦儀器確認
觸發，它就不會接受其他觸發。除非已完成擷取，而且延滯時間已到期。

觸發模式
若觸發事件沒有出現，觸發模式會決定儀器應採取的行動：

一般觸發模式限制示波器只在被觸發時才擷取波形。如果沒有觸發事件，螢幕將一直顯示上次擷
取到的波形記錄。如果上次沒有擷取任何波形，螢幕將不顯示任何波形。

自動觸發模式將使示波器自動擷取波形，即使沒有任何觸發。自動模式使用觸發事件發生之後開
始的計時器。若是在計時器逾時之前還未偵測到其他觸發事件，示波器就會強制觸發。觸發事件
的等候時間長度取決於時基設定。

自動模式缺乏有效觸發事件時所強制進行的觸發，不會和顯示中的波形同步。該波形會在整個螢幕上
捲動。如果發生了有效觸發，畫面就會穩定下來。

在 邊緣觸發模式中，您也可以按一下 Trigger Setup (觸發設定) 控制視窗中的 Force Trigger (強制觸發) 按
鈕來強制觸發儀器。

在 Trig > Mode (觸發>模式) 功能表中選取觸發模式。如需更多資訊，請參閱示波器線上說明。

觸發延滯
觸發延滯有助於穩定觸發， 藉由延長觸發期間，可在啟動擷取之後抑制進一步的 觸發辨識。這樣的
延長可幫助系統 跳過循環脈衝事件的剩餘事件，如此一來， 就可使每一次的脈衝皆觸發到第一個事
件。當儀器觸發到不想要的觸發事件時， 請調整延滯，以保持穩定觸發。

在 Trig > Holdoff (觸發>延滯) 功能表設定觸發延滯。如需更多資訊，請參閱示波器線上說明。

觸發耦合
觸發耦合會決定要將哪個訊號部份傳遞給觸發電路。邊緣觸發可使用所有的耦合類型： AC、DC、低
頻排斥、高頻排斥和雜訊排斥。所有其餘觸發類型只能使用「DC 耦合」。 您的儀器可能不會提供所
有的耦合類型。
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在 Trig > A Event (Main) Trigger Setup (觸發 > A 事件 (主要) 觸發設定) 功能表中選取觸發耦合。如需更
多資訊，請參閱示波器線上說明。

水平位置
水平位置可定義波形記錄中觸發的發生位置。您可透過它來選擇儀器在觸發事件前後所要擷取的時間。
在觸發之前所發生的記錄部份，就是前置觸發部份。在觸發之後發生的部份，即為後置觸發部份。

前置觸發資料有助於故障排除。例如，如果您想了解為何測試電路產生不想要的突波，您可觸發該突
波，並使前置觸發期間長到足以擷取突波之前的資料。您可以分析該突波之前發生哪些現象，找出一
些資訊來研究其發生原因。如果您想了解觸發事件會對系統造成哪些影響，您可加長後置觸發期間，
以便足夠用來擷取觸發後的資料。

斜率和位準
斜率控制項定義示波器找到的訊號上升∕下降邊緣上的觸發點。位準控制項決定觸發點在邊緣上的發
生位置。

延遲的觸發系統
您可單獨觸發 A (主要) 觸發系統，或是結合 A (主要) 觸發和 B (延遲) 觸發來觸發次序事件。如果是
使用次序觸發，A 觸發事件會啟動觸發系統。而當 B 觸發條件符合時，B 觸發事件就會觸發儀器。A
和 B 觸發可以 (通常也是如此) 具有不同的來源。B 觸發條件是根據時間延遲或特定事件數。 ( 請參閱
頁68，使用 A (主要) 和 B (延遲) 觸發)

選擇觸發類型
本儀器讓您可從前面板修改基本的觸發參數，或在「Trigger Setup」 (觸發設定) 控制視窗中設定更多
進階的觸發。

注意。 有些觸發方式選項不適用於某些儀器。

1. 選取「Trig > Edge Setup」(觸發 >
邊緣設定)。
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2. 使用設定功能表設定來源、斜率、
耦合和模式。
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3. 若要選取其他的觸發類型之一，
請直接從「Trig」(觸發) 功能表選
取觸發類型。

4. 使用顯示觸發類型的控制項，完
成觸發設定。用來設定觸發的控
制項，將依觸發類型、儀器型號
與選項而有所不同。
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觸發選項

觸發方式 觸發條件

邊緣 請依斜率控制項的定義，觸發上升或下降邊緣。耦合選擇可為直流、
交流、低頻排斥、高頻排斥和雜訊排斥。

突波 觸發比指定寬度更窄 (或更寬) 的脈波，或是忽略比指定寬度更窄 (更
寬) 的突波。

寬度 觸發指定時間範圍內∕外的脈波。您可在正脈波或負脈波上觸發。

矮波 觸發一脈波振幅。它可與第一個臨界值交叉，但再度交叉第一個臨界
值之前，無法與第二個臨界值相交。您可以偵測正矮波或負矮波，或
是只偵測比指定寬度還寬的矮波。這些脈波也可以被其他波道的邏輯
狀態限定。

視窗 當輸入訊號高於上方臨界水平或低於下方臨界水平時觸發。當訊號正
在進入或離開臨界視窗時觸發儀器。請使用 Trigger When Wider (較寬
時觸發) 選項，以時間來限定觸發事件。或視其他波道的邏輯狀態而
使用 Trigger When Logic (邏輯時觸發) 選項。

逾時 在指定時間內沒有偵測到任何脈波時觸發。

轉態 當脈波邊緣穿越兩個臨界值間的速率快∕慢於指定時間時，觸發脈波
邊緣。這種脈波邊緣可為正向或負向。

串列 在最快 1.25 Gb/s 資料速率的 64 位元 NRZ 串列樣式下觸發，以及在
最快 6.25 Gb/s 資料速率的 4 個 8b/10b 符號下觸發 (僅 MSO70000C/DX
和 DPO70000C/DX 適用 )。需要選項 ST1G (DPO7000C) 或 ST6G
(MSO70000C/DX 和 DPO70000C/DX)。包含時脈還原。按下「Push to Set
50%」(按下設定 50%) 控制項可重新初始時脈還原。

「位置鎖定」可自動尋找並鎖定長而重複的虛擬隨機位元程序 (Pseudo-
random bit sequence，PRBS)。這項鎖定表示儀器知道虛擬隨機位元程
序的位元長度，並可預測循環重複的時間。「位置鎖定」可讓儀器
以具有顯著時基精確度的資料樣式在特定位置取樣。需配合 ST1G 或
ST6G 選項。

模式 當邏輯輸入值使選定的函數成為 TRUE或 FALSE 時觸發。您也可以指
定：邏輯條件必須滿足特定次數後才觸發。

如果使用一個以上的來源或外部觸發器，則不建議搭配 iCapture 輸入
使用。

狀態 當所有邏輯輸入值使選定的函數成為 True 或 False 且時脈輸入值變更
狀態時觸發。

如果使用一個以上的來源或外部觸發器，則不建議搭配 iCapture 輸入
使用。

設定∕保持 當邏輯輸入值在與時脈相關的設定時間及保持時間內改變狀態時觸
發。模式在設定和保持違反時觸發。

如果使用一個以上的來源或外部觸發器，則不建議搭配 iCapture 輸入
使用。

通訊 請在通訊碼和標準上結合遮罩測試進行觸發 (僅類比波道)。 您可同
時使用這些控制項來定義觸發事件的參數 (需配合某些儀器上的 MTM
或 MTH 選項)。這個模式包含時脈還原。 按下「Push to Set 50%」(按
下設定 50%) 旋鈕可重新初始時脈還原。
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觸發方式 觸發條件

匯流排 觸發您要定義的匯流排元件 (例如指定的位址)。 在某些儀器和選項
中，觸發類型包括並列、SPI、RS-232、USB 和 I2C 觸發。

如果使用一個以上的來源或外部觸發器，則不建議搭配 iCapture 輸入
使用。

視訊 觸發指定的圖場或合成視訊訊號線條 (僅限 DPO7000、MSO5000 和
DPO5000 系列)。僅支援合成訊號格式。

CAN 觸發 CAN 匯流排訊號。

如果使用一個以上的來源或外部觸發器，則不建議搭配 iCapture 輸入
使用。
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檢查觸發狀態
您可以從前面板狀態燈或讀值來檢查觸發狀態。

檢查ARM、READY和 TRIG'D等前面
板控制項來判斷觸發狀態。

如果 TRIG'D 燈亮起，表示儀器已
確認有效的觸發，且正在建構波
形的後置觸發部份。

如果READY燈亮起，表示儀器可
接受並正在等候有效的觸發發生。
前置觸發資料已取得。

如果ARM燈亮起，表示觸發電路
正在建構波形記錄的前置觸發部
份。

如果 TRIG'D 和 READY 都亮燈，
表示已確認有效的 A 事件觸發，
而且儀器正在等候延遲觸發。確
認延遲觸發後，將建構延遲波形
的後置觸發部份。

如果 ARM、TRIG'D 和 READY 燈
都沒有亮起，表示擷取已經停止。

MSO/DPO70000DX、MSO/DPO70000C 和 DPO7000C 系列

若要快速判斷某些重要觸發參數的設
定，請檢查螢幕下方的觸發讀值。邊
緣觸發和進階觸發的讀值並不同：

1. A 觸發源 = Ch1

2. 觸發斜率 = 上升邊緣

3. 觸發位準

4. 時基

5. 檢查 ARM、READY 和 TRIG'D 等
讀數來判斷觸發狀態。

6. 檢查自動/一般讀數來判斷觸發模
式。
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使用 A (主要) 和 B (延遲) 觸發
您可以單獨使用簡單訊號的 A事件 (主要) 觸發，或將它結合 B事件 (延遲) 觸發以擷取較複雜的訊號。
A 事件發生之後，觸發系統會先尋找 B 事件，然後才觸發和顯示波形。

A 觸發

1. 選取 Trig > A Event (Main) Trigger
Setup...(觸發> A事件(主要)觸發設
定...)。

2. 在 A Event (A 事件) 索引標籤中設
定 A 觸發方式和來源。

B 觸發 (延遲)

注意。

3. 在 A →B Seq (A →B 次序) 索引標
籤中選擇函數。

4. 設定觸發延遲時間或B事件數量。
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5. 在 B Event (Delayed) (B 事件 (延遲))
索引標籤中設定 B 觸發特性。

6. 在 Mode (模式) 索引標籤中，選取
Normal (一般)觸發模式和「Auto」
(自動) 延滯。

觸發 B 事件

A 觸發會啟動示波器。後置觸發擷取
開始於第 n 個 B 事件。

延遲時間後的 B 觸發

A 觸發會啟動示波器。在觸發延遲時
間之後的第一個B邊緣上開始後置觸
發擷取。
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重置觸發

您可以指定當某條件在 B 觸發事件
前發生時，便重置觸發系統。重置事
件發生後，觸發系統即停止等候B事
件，並恢復成等候 A 事件。

MSO5000和 DPO5000儀器無法使用重
置觸發。

快速秘訣
B 觸發延遲時間和水平延遲時間是各自獨立的功能。當您單獨使用 A 觸發或同時使用 A 和 B 觸發
建立觸發情況時，您也可以使用水平延遲進行額外數量擷取的延遲。

更正觸發位置
「觸發位置更正」可更正資料路徑和觸發路徑上的偏差，更精確地將觸發放在顯示的波形上。「觸發
位置更正」也可使用平均，更精確地將觸發放在雜訊訊號上。若要更精確地將邊緣觸發放在畫面上，
請執行下列程序：

1. 若要更精確地將觸發放在畫面上，
請勾選 Enhanced Triggering (加強型
觸發)。若要更精確地將觸發放在
雜訊訊號上，也請勾選 Optimized
for Noisy Signals (針對雜訊訊號最
佳化)。

若要勾選Optimized for Noisy Signals
(針對雜訊訊號最佳化)，必須先
勾選 Enhanced Triggering (加強型觸
發)。
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使用 B 事件掃描進行觸發
使用「A->B 序列」的「B 事件掃描」以建立由 A 觸發事件進行同步化和初始化的重疊眼狀圖。

MSO5000 和 DPO5000 儀器無法使用乙事件掃描。

「在第 n 個事件觸發」會針對所有擷取來擷取發生於 A 事件之後的第 n 個 B 事件。「B 事件掃描」會
自動提高 B 事件的值以擷取不同部分的訊號。

1. 在「A Event」(A 事件) 索引標籤
中設定 A 觸發類型和來源。

2. 在「B Event」(B事件)索引標籤中
設定 B 觸發類型和來源。

3. 若要更精確地將觸發放在畫面
上，請勾選「Enhanced Triggering」
(加強型觸發)。若要更精確地將
觸發放在雜訊訊號上，也請勾選
「Optimized for Noisy Signals」(針
對雜訊訊號最佳化)。
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4. 在「A>B Seq」(A>B 次序) 索引標
籤中選取「Trig on nth Event」(在第
n 個事件觸發) 和「B Event Scan」
(B 事件掃描)。

5. 若要顯示「B Event Scan Setup」
(B 事件掃描設定) 視窗，按下「B
Event Scan > Setup」(B 事件掃描 >
設定)。

6. 設定 B 事件開始值。

7. 設定 B 事件結束值。

8. 設定B事件值遞增前的擷取次數。

9. 選取在所選擷取次數到達後 B 事
件值會遞增的方法：

「Sequential Scan」(次序掃描)
以 1 遞增直到達到「結束事
件」。達到「End Event」(結束
事件) 時，會將 B 事件值重設
為「Start Event」(開始事件) 值
並重新開始程序。

「Random Scan」(隨機掃描) 會
針對每一組「Advance After」
(在此事件後提高) 擷取將 B 事
件值設定為介於「Start Event」
(開始事件) 和「End Event」(結
束事件) 之間的隨機值。

「Toggle Between Events」(切換
事件) 可針對每一組「Advance
After」(在此事件後提高) 擷取
將B事件值在「Start Event」(開
始事件) 和「End Event」(結束
事件) 之間切換。
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10. 在此範例中，DDR3 DQS訊號位於
Ch 1，DQ 訊號位於 Ch 2。儀器在
「執行模式」下，「顯示模式」
設定為「無限餘輝」。儀器的觸
發設定如下：

Ch 1 上的「A 事件視窗觸發」
以檢測 DDR3 DQS 寫入條件。

Ch 1 上「任一斜率的 B 事件邊
緣觸發」以在DQS (時脈)邊緣
觸發。

A->B次序設定為「在第 n個事
件觸發」。

B掃描以開始事件啟動 = 1、結
束事件 = 8 而模式 = 次序。

資料眼是由 Ch2 上的 DQ 訊號
組成。

觸發並列匯流排
觸發並列匯流排來找出問題。MSO 儀器可使用數位波道作為並列匯流排的元件。

1. 選取「Trig > A Event (Main) Trigger
Setup...」(觸發 > A 事件 (主要) 觸
發設定...)。

2. 選取「A Event」(A 事件) 索引標
籤。

3. 選取「Bus」(匯流排) 觸發類型。

4. 選取要觸發的匯流排。

注意。 如果時脈來源設定為 Ch4，
則時脈匯流排僅會顯示在下拉式清單
中。
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5. 選取資料格式。

6. 使用鍵盤來設定要觸發的樣式。

7. 分析您的波形。
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觸發串列匯流排
觸發串列匯流排來找出問題。串列匯流排僅適用於 MSO/DPO70000DX、MSO/DPO70000C、DPO7000C、
MSO5000 和 DPO5000 系列儀器。數位通道可用於 MSO 儀器上的匯流排定義中。

設定串列匯流排。( 請參閱頁47，設定匯流排)

1. 選取「Trig > A Event (Main) Trigger
Setup...」(觸發 > A 事件 (主要) 觸
發設定...)。

2. 選取「A Event」(A 事件) 索引標
籤。

3. 選取「Bus」(匯流排) 觸發類型。

4. 選取匯流排。

5. 選取要觸發的匯流排訊號。

6. 根據您的「Trigger On」(觸發開啟)
選擇和匯流排類型，請為匯流排
選擇必要的選項。

請參閱線上說明，以取得設定匯
流排的詳細說明。
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使用視覺觸發進行觸發 (視覺觸發)
視覺觸發可允許您直接在顯示螢幕上建立觸發條件。 (視覺觸發為可供使用的選項。)

1. 使用左鍵按一下並拖曳螢幕上的
方塊以建立視覺觸發區域。 然
後從功能表選取「Add Visual Trig
Area」(新增視覺觸發區域)。

注意。 此功能表能讓您隱藏或顯示
所有視覺觸發區域，並可切換開啟或
關閉視覺觸發。

2. 按一下區域以啟用拖曳點。 按一
下並拖曳區域以將該區域移動至
新位置。 按一下並拖曳其中一個
區域拖曳點以垂直、水平或雙向
調整區域的大小。
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3. 在視覺觸發區域按一下滑鼠右鍵，
並從功能表選取「Visual Trigger
Area」(視覺觸發區域)。

使用視覺觸發功能表編輯觸發區域和
設定視覺觸發的條件。

請參閱線上說明，以取得關於建立和
編輯視覺觸發的詳細資訊。

4. 從「Trig」(觸發) 功能表，選取
「Visual Trigger Setup」(視覺觸發
設定)，然後按兩下「Visual Trig-
ger」(視覺觸發) 公式。

請參閱線上說明，以取得關於使用合
格運算式編輯器的詳細資訊。
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設定依事件採取動作
依事件採取動作可允許您設定示波器，以在定義的事件 (例如觸發事件、遮罩測試失敗和極限測試失
敗) 發生時儲存各種檔案。

1. 選取「File > Action on Event」(檔
案 > 依事件採取動作)。

2. 選取要使用的事件。

3. 選取事件發生時所採取的動作。
選取「 Save 」 ( 儲存 )、「 Send
E-mail」(傳送電子郵件) 或兩者皆
選。

使用「Setup」(設定)按鈕 (「Save」(儲
存) 旁) 以顯示「Save on Event Setup」
(依事件儲存設定) 顯示螢幕。

使用「Setup」(設定) 按鈕 (「Send
E-mail」(傳送電子郵件) 旁) 以顯示
「Send E-mail Setup」(傳送電子郵件
設定) 顯示螢幕。 ( 請參閱頁80，設
定「依事件發出電子郵件」)

4. 輸入儲存檔案的位置。

5. 選取開始儲存的事件。

6. 選取事件發生時所儲存的檔案類
型。

7. 設定所使用的檔案命名慣例。

8. 設定要儲存的事件數。
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依觸發傳送電子郵件
您必須先設定「依事件發出電子郵件」，才能執行下列程序。 ( 請參閱頁80，設定「依事件發出電子
郵件」)

1. 選取 Trig > A Event (Main) Trigger
Setup...(觸發> A事件(主要)觸發設
定...)。

2. 選取 Mode (模式) 索引標籤。

3. 在 E-mail on Trigger (依觸發傳送電
子郵件) 表下，按一下「On」(開
啟)，再按一下 Setup (設定)。 ( 請
參閱頁80，設定「依事件發出電
子郵件」)
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設定「依事件發出電子郵件」
1. 選取「Utilities > E-mail on Event >

Setup... (公用程式 > 依事件發出電
子郵件 > 設定...)。

2. 輸入收件人的電子郵件地址。使
用逗號分隔多個地址項目。電子
郵件地址方塊的長度限制是252個
字元。

3. 按一下「Config」(組態)，然後輸
入 SMTP 伺服器位址。請聯絡網
路管理員取得正確位址。
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4. 選取當發生時要發送電子郵件的
事件。

5. 如果要包含附件，請選取附件類
型，再按一下「Settings」(設定)來
指定格式。

6. 設定最大訊息限制和電子郵件大
小。如果已到達最大訊息限制，
您必須按一下「Reset」(重設)，才
能再依事件發出電子郵件。

7. 若要驗證您設定的電子郵件地址
無誤，請按一下「Send」(傳送)來
傳送測試郵件。

8. 如有需要，請按一下「Config」(組
態) 來存取電子郵件組態對話方
塊，並調整其組態。
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使用水平延遲
使用水平延遲，可在重要時間間隔分
隔的觸發位置區域中擷取波形細節。

1. 選取「Horiz/Acq > Horizontal/Acqui-
sition Setup」(水平/擷取 > 水平/擷
取設定)。

2. 按下「Delay Mode」(延遲模式)按
鈕，將延遲模式切換成開啟。

3. 使用水平 POSITION (位置)控制項
來調整延遲時間，或在控制視窗
輸入延遲時間。

4. 調整水平 SCALE (刻度)來擷取所
需細節。

快速秘訣
您可同時使用 MultiView 縮放和水平延遲功能來放大延遲的擷取。

開啟和關閉水平延遲功能，便可快速比較在兩個不同重要區域的訊號細節。一個是接近觸發區域，
另一個則位在延遲時間的中央。
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顯示波形
本節將介紹顯示波形的概念和程序。線上說明將提供詳細資訊。

設定顯示樣式
如果要設定顯示樣式，請選取 Display
> Display Style (顯示>顯示樣式)，再選
取下面一種樣式：

在記錄點和點之間畫
線來顯示波形。

將波形記錄點顯示為
螢幕上的點。

顯示實際取樣。不顯
示內插產生的點。
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設定顯示餘輝
選取 Display > Display Persistence (顯示
> 顯示餘輝) 以選取餘輝方式。

無餘輝將只顯示目前擷取的記錄
點。每筆新的波形記錄都會取代
前一個擷取到的波道記錄。

無限餘輝會持續累積記錄點，直
到您改變其中一個擷取顯示設定。
用於顯示出現在一般擷取包封以
外範圍的點。

可變餘輝指定了時間間隔的記錄
點。每個記錄點會根據時間間隔
個別消失。

重置餘輝可清除餘輝。

1. 如果要設定可變餘輝，請選取
「Display > Display Persistence > Per-
sistence Controls...」 (顯示>顯示餘
輝> 餘輝控制項...)。

2. 按一下Variable (可變)、Persist Time
(餘輝時間)，再使用多用途旋鈕來
設定餘輝時間。
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設定顯示格式
本儀器可以顯示三種不同的波形格式。請選擇最適合您需求的格式。

選取Display > Display Format (顯示>顯
示格式)。

選取YT格式，可顯示隨時間而不
同的訊號振幅。

選取 XY 格式，便可 逐點比較波
形記錄的振幅：

比較下列波道：

Ch 1 (X) 和 Ch 2 (Y)、

Ch 3 (X) 和 Ch 4 (Y)、

Ref 1 (X) 和 Ref 2 (Y)、

Ref 3 (X) 和 Ref 4 (Y)

選取 XYZ 格式，便可如同在 XY
格式般，逐點比較Ch 1 (X) 和 Ch 2
(Y) 波形記錄的電壓位準。顯示的
波形強度由Ch 3 (Z) 波形記錄來調
變。觸發 XYZ 格式。Ch 3 上的 -5
分格訊號 (包含位置和偏移) 產生
空白螢幕，+5 分格訊號產生完全
強度。

快速秘訣
XY 格式在判讀如李塞爾氏圖形 (Lissajous Pattern) 的相位關係時特別有用。

XY 格式是僅顯示點的顯示格式，雖然這種格式也具有持續性。如果是選取 XY 格式，「向量樣
式」不會產生任何作用。
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選取波形內插法
選取 Display > Waveform Interpolation
( 顯示> 波形內插法)，再選取下面
一項方法：

Sin(X)/X 內插法會應用最佳曲線，
計算出介於實際擷取取樣之間的
記錄點。

Linear (線性) 內插法會應用最適直
線，計算出介於實際擷取取樣之
間的記錄點。
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快速秘訣
Sin(X)/X 內插法是預設的內插模式。比起線性內插法，它在準確呈現波形時所需的實際取樣點數較
少。

增加螢幕文字
1. 選取 Display > Screen Text (顯示>螢

幕文字)。

2. 最多可輸入 8 行 (分開) 文字。

3. 按一下 Text (文字) 的 Off (關閉) 或
「On」(開啟)，便可開啟或關閉文
字顯示。

4. 按一下Font (字型)或Color (色彩)，
便可選取螢幕文字的字型和色彩。

5. 按一下 Controls (控制)，便可開啟
「文字內容」控制視窗來設定顯
示中的文字位置。

6. 按一下Clear (清除)，便可消除選
定行的所有文字。

快速秘訣
您可以從螢幕上按一下並拖曳螢幕文字，為其重新定位。

您也可以標示波形和匯流排。 ( 請參閱頁46，設定數位波道) ( 請參閱頁47，設定匯流排)
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設定方格圖樣式

如果要設定方格圖樣式，請選取 Dis-
play > Graticule Style (顯示>方格圖樣
式)，再選取下面一種樣式：

用於快速估計波形參
數。

用於不需要十字線
時，顯示包含游標和
自動讀值的全螢幕測
量值。

用於快速估計波形，
以便留下更多空間
給自動讀值和其他資
料。

用於不需要顯示功能
時，顯示自動讀值和
其他螢幕文字。

用於顯示 NTSC 視訊
訊號。

用於顯示非 NTSC 的
其他視訊訊號。

設定觸發位準標記

1. 請選取 Display > Objects... (顯示>
物件...)。

2. 選取下列選項之一：

Short (短)：在方格圖旁邊顯示
短箭頭。

Long (長)：顯示橫跨方格圖的
水平線。

Off (關閉)：關閉觸發位準標
記。
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顯示日期和時間
1. 選取 Display > Objects... (顯示>物

件...)。

2. 切換方格圖中 Date/Time (日期/時
間) 的顯示。使用 Utilities (公用程
式) 功能表來設定日期和時間。
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使用調色盤
選取Display > Record View Palette (顯示
>記錄檢視調色盤)或 FastAcq/WfmDB
Palette (快速擷取∕波形資料庫調色
盤)，再選取波形和方格圖的色彩組
合之一：

Normal (一般) 選項將顯示最佳整
體檢視的色調和亮度。每個波道
波形的顏色皆符合前面板垂直旋
鈕的對應色彩。

Temperature Grading (溫階) 選項會
以紅色來顯示出現最高取樣密度
的波形區域。最低取樣密度的區
域則呈現為藍色。

Monochrome (單色綠色) 選項以淺
綠色來顯示出現最高取樣密度的
波形區域。最低取樣密度的區域
則呈現深綠色。這很仿似類比示
波器的顯示顏色。

Spectral Grading (頻譜層次) 選項以
藍色來顯示出現最高取樣密度的
波形區域。最低取樣密度的區域
則呈現紅色。

Monochrome Gray (單色灰色) 選項
以淺灰色來顯示出現最高取樣密
度的波形區域。最低取樣密度的
區域則呈現深灰色。

User (使用者) 選項以使用者定義
色彩來顯示波形。

快速秘訣
在Display > Colors (顯示>色彩) 控制視窗中選擇其中一組色階調色盤，便可查看不同顏色代表的不
同取樣密度。

調色盤有二種。一種用於 Record View (記錄檢視)，另一種用於 FastAcq/WfmDB (快速擷取∕波形資
料庫)。
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設定參考波形的色彩
選取Display > Colors...(顯示>色彩...)，
再選取下列方法之一：

Default (預設)：使用參考波形預設
的系統色彩。

Inherit (沿用)：使用相同於原參考
波形的色彩。

設定數學波形的色彩
選取 Display > Colors...( 顯示＞色
彩...)，然後選擇下列選項其中之一：

Default (預設)：使用數學波形預設
的系統色彩。

Inherit (沿用)：使用相同於套用數
學函數之最小編號波道波形的色
彩。

快速秘訣
每個數學波形和參考波形使用不同的預設色彩。

使用 MultiView 縮放
使用 MultiView Zoom 功能，可垂直、水平、或等比例放大波形尺寸。縮放過的波形也可以排列、鎖定
和自動捲動。Scale (刻度) 和 Position (位置) 設定只會影響畫面，而不會影響到實際波形資料。

1. 如果「MultiView Zoom」為關閉，
按下「MultiView Zoom」可分割螢
幕並加入縮放方格圖。
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2. 按下 HORIZ (水平) 或 VERT (垂
直)，可選取要放大縮放方格圖中
哪一條軸線。使用多用途旋鈕可
調整放大波形的刻度和位置。

這個範例的主要方格圖是方格圖
的上半部，縮放方格圖是方格圖
的下半部。

注意。 若要隱藏或顯示縮放波形，
請按「Show/Hide Waveforms」(顯示/
隱藏波形)，再勾選要顯示的縮放波
形。

3. 如果要調整縮放方格圖尺寸，請
從Vertical (垂直)或Horiz/Acq (水平
∕擷取)功能表選取 Zoom Graticule
Size (縮放方格圖尺寸)。

4. 如果「MultiView Zoom」為開啟，
但縮放控制項未與讀數連接，按
下「MultiView Zoom」按鈕即可連
接讀數與縮放控制項。 再按一次
「MultiView Zoom」按鈕可關閉縮
放。

快速秘訣
您也可以使用 Zoom Setup (縮放設定) 功能表來變更縮放波形的方格圖尺寸。

使用 Wave Inspector 來管理長記錄長度波形。 ( 請參閱頁97，使用 Wave Inspector 來管理長記錄長度
波形)
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在多塊區域縮放
如果您想同時檢視和比較同一筆記錄中的多塊區域，請使用下列程序。

1. 在您想要縮放的波形區域周圍按
一下滑鼠，拖曳出一個矩形。

2. 選取 Zoom 1 On (縮放 1 開啟)。

3. 在另一個要縮放的波形區域周圍按
一下滑鼠，拖曳出一個矩形，然
後選取 Zoom 2 On (縮放 2 開啟)。

4. 如果要水平調整縮放區域，請按一
下該縮放矩形下方的水平標記，
以選取縮放區域。

5. 請使用多用途旋鈕來調整選定縮
放波形的水平位置和縮放係數。
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6. 如果要垂直調整該縮放區域，請
選取Vertical > Zoom Setup...(垂直>
縮放設定...)，按一下垂直圖場，
再使用多用途旋鈕來調整垂直位
置和縮放係數。

快速秘訣
如果要清除縮放區域，請按一下 Zoom Setup (縮放設定) 控制視窗中的 Position Factor Reset (位置係數
重置)。

您可以從 Zoom Setup (縮放設定) 控制視窗開啟、關閉每個縮放顯示。

按一或兩下「MultiView Zoom」按鈕可切換所有縮放顯示的開關狀態。

如果要重新定位縮放區域的水平位置，請按一下並拖曳縮放矩形底部的水平標記。

使用 Wave Inspector 來管理長記錄長度波形。 ( 請參閱頁97，使用 Wave Inspector 來管理長記錄長度
波形)

鎖定和捲動縮放波形
1. 如果要使用 Lock and Scroll (鎖定

和捲動)，請在 Vertical (垂直) 或
Horiz/Acq (水平∕擷取) 功能表選
取Zoom Setup...(縮放設定...)，再選
取 Lock and Scroll (鎖定和捲動)索
引標籤。
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2. 如果要捲動單一縮放區域，請選
取 Zoom 1-4 (縮放 1-4)核取方塊，
再按一下Auto Scroll (自動捲動)按
鈕。

3. 如果要同時捲動多塊縮放區域，
請按一下 Lock (鎖定)，再選取
Zoom 1-4 (縮放 1-4) 核取方塊。

鎖定縮放區域可鎖定它們的相對
水平位置。改變一個已鎖定縮放
區域的水平位置，就會改變全部
的水平位置。
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快速秘訣
如果只有選取多塊縮放區域卻沒有鎖定，最大編號的縮放區域將自動捲動，而其他縮放區域則維
持不動。

隱藏縮放視窗中的波形
1. 若要隱藏或檢視波形，請從「Ver-

tical」(垂直) 或「Horiz/Acq」(水
平∕擷取) 功能表選取「Zoom
Setup...」(縮放設定...)。

2. 選取「Zoom」(縮放) 索引標籤，
然後按下「Show/Hide Waveforms」
(顯示/隱藏波形)。

3. 選取要顯示或隱藏之波形的所在
縮放區域。

4. 取消勾選您要隱藏的波道、算術
運算、參考或數位波形。

僅 MSO 系列儀器可使用數位波道。
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使用 Wave Inspector 來管理長記錄長度波形
Wave Inspector 控制項 (左右移動/縮放、播放/停止、標記、搜尋) 可協助您有效率地利用長記錄長度波
形。若要水平放大波形，請旋轉「Zoom」(縮放) 旋鈕。若要捲動整個縮放波形，請旋轉飛梭旋鈕。

MSO5000 和 DPO5000 系列儀器上可使用 Wave Inspector。

左右移動-縮放控制包括：

1. 外飛梭旋鈕

2. 內縮放旋鈕

縮放波形

若要使用縮放：

1. 順時針方向旋轉左右移動-縮放控
制的內旋鈕，可以縮小選取的波
形部分。逆時針旋轉旋鈕，可以
放大回來。

2. 此外，按一下或兩下縮放按鈕，
就可以啟用或停用縮放模式。

( 請參閱頁91，使用 MultiView 縮放)
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3. 檢查顯示中較大下半部所出現的
縮放波形檢視。 顯示的上半部會
在全部記錄內容中，顯示波形縮
放部分的位置和尺寸大小。

左右移動波形

當縮放功能啟用時，使用左右移動功能，快速捲動整個波形。若要使用左右移動功能：

1. 旋轉左右移動-縮放控制的飛梭
(外側) 旋鈕，來左右移動波形。

順時針旋轉旋鈕，可向前移動。
逆時針旋轉，可向後移動。旋轉
旋鈕越多，縮放視窗移動速度就
會越快。

播放和暫停波形

使用播放-暫停功能，可自動左右移動整個波形記錄。若要使用這項功能：

1. 按下播放-暫停按鈕，可啟用播
放暫停模式。

2. 更進一步旋轉飛梭 (外側)旋鈕，
就可調整播放速度。旋轉越多，
速度就會越快。
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3. 反向您旋轉飛梭旋鈕的方向，就
可以改變播放方向。

4. 進行播放時 (直到某一點後)，當
您旋轉外旋鈕越多，波形加速的
速度會越快。 當您將外旋鈕旋
轉到最底時，就不能改變播放速
度，但是縮放方塊會快速朝該方
向前進。 使用最大旋轉功能，
來播放您已看過並希望重看一次
的波形部分。

5. 再按一次播放-暫停按鈕，便會
暫停播放暫停模式。

搜尋和標記波形
您可以從擷取的波形來標記特定的位置。這些標記有助於限制自己分析特定波形區域。您可以自動
標記符合特殊條件的波形區域，或是手動標記每個特定項目。您可以在標記之間跳躍移動 (在特定區
域之間移動)。您可自動搜尋並標記多個能夠觸發的相同參數。 許多搜尋參數沒有將時間限制作為觸
發。您可以搜尋數學和參考波形。您可以尋找特定類型的所有擷取事件。

搜尋標記提供了標記波形區域來作為參考的方式。您可以使用搜尋條件，自動設定標記。您可以使用
特定邊緣、脈波寬度、矮波、邏輯狀態、上升/下降時間、設定和保持違反以及匯流排等搜尋類型，
搜尋並標記區域。

搜尋和標記不支援數位波形。
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若要手動設定並清除 (刪除) 標記：

1. 開啟「Multiview Zoom」。使用
Zoom 1 (附標記)。

( 請參閱頁91，使用 MultiView 縮放)

2. 選取 Analyze > Search (分析 > 搜
尋)。

3. 旋轉多功能旋鈕，移動 (縮放方塊)
到您要設定 (或清除) 搜尋標記的
波形區域。

按下「Next」 (下一個) (→) 或
「Prev」(上一個) (←) 箭頭按鈕，
跳到現有標記。

4. 按下「Set Clr」(設定清除)，或前
面板「Set/Clear」(設定/清除) 按
鈕。

如果螢幕中央沒有出現任何搜尋
標誌，儀器就會增加一個標誌。

建立標記後，則會儲存水平縮放
係數。使用 Next (下一個) 或 Prev
(上一個)按鈕在標記之間移動時，
則會還原縮放係數。
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5. 在搜尋標記之間移動，調查研究
您的波形。使用「Next」(下一個)
(→) 或「Prev」(上一個) (←) 箭頭
按鈕，從一個標記位置跳到另一
個標記位置，而無需調整任何其
他的控制項。

6. 刪除標記。按下「Next」(下一個)
(→) 或「Prev」(上一個) (←) 箭頭
按鈕，跳到您想要清除的標記。
若要移除置中位置的標記，只需按
下「Set Clr」(設定清除)，或前面
板「Set/Clear」(設定/清除)按鈕。
這對於手動與自動建立的標誌都
有用。
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若要自動設定並清除 (刪除) 搜尋標記：

1. 按下「Search」(搜尋)或選取「An-
alyze > Search」(分析 > 搜尋)。

2. 從功能表選取所需要的搜尋類型。

搜尋功能表很類似觸發功能表。

串列匯流排搜尋為選用選項。

3. 從 Configure (組態) 索引標籤設定
搜尋。若要複製觸發設定或搜尋
設定，請按下 Settings Copy (設定
複製)。

4. 從 Copy Settings (複製設定) 視窗
選取設定的複製來源和複製目的
地。按Copy (複製)，再按Close (關
閉)。
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5. 若要修改目前的搜尋設定，請調
整所顯示的控制項。顯示的控制
項因您選取的搜尋而異。

6. 如果尚未開啟，請按 Search (搜
尋)，切換成開啟搜尋。

7. 在這個螢幕中，三角形表示自動
標誌的位置，白色框線的三角形
則表示自訂 (使用者定義) 的標誌
位置。這些標記都可出現在一般
或縮放過的波形檢視。
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8. 利用「Next」 (下一個) (→) 與
「Prev」(上一個) (←) 箭頭按鈕，
在標誌之間移動，快速探究您的
波形。不需要其他調整。

9. 若要切換顯示搜尋事件計數或標
記時間，請選取 Results (結果) 索
引標籤，並按View (檢視)的 Count
(計數)。

10. 若要清除表格的所有標記，請按
All Marks (所有標誌) 的 Clear (清
除)。

11. 若要將標記表匯出至檔案，請按
All Marks (所有標誌) 的Export (匯
出)。

12. 若要將一個或所有標記轉換為使
用者標記，請按 Search Marks (搜
尋標記) 的 Save (儲存) 或 Save All
(存全部)。

13. 若要從標記表中移除目前反白的
資料列，請按 Search Marks (搜尋
標記) 的 Clear (清除)。

14. 若要切換以工程表示法或以高精
準度表顯示標記位置，請按 Digits
(位數)。
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15. 若要切換開啟和關閉顯示標記三
角形，請選取 View (檢視) 索引標
籤，並按Show Marks (顯示標記)。

16. 若要在找到符合項目時停止擷取，
請選取 Mode (模式) 索引標籤，並
勾選 Stop Acquisition if event found
(找到事件便停止擷取)。

快速秘訣
只搜尋擷取到的資料。設定儀器擷取您正在搜尋的資料。

設定可辨別搜尋事件的取樣率。您可以搜尋大於一些取樣間隔的突波。

您可以複製觸發設定，在擷取波形中搜尋符合觸發條件的其他位置。您可以複製搜尋設定到觸發。

建立邊緣搜尋標記時不需要縮放係數。其他搜尋類型使用適當的縮放係數建立標記。

按 Bring Zoom to Mark (縮放標記) 的 Zoom 2 (縮放 2) 或 Zoom 3 (縮放 3)，可使用 Zoom 1 (縮放 1) 的
縮放參數，顯示對應的縮放檢視。

在儲存波形以及儲存設定時，自訂 (使用者) 標記就會隨波形一起儲存。

當儲存波形時，自動搜尋標記不會隨著波形一起儲存。然而，搜尋條件會儲存在已儲存的設定中，
因此您可以再使用搜尋功能，輕鬆地重新擷取這些標記。

「搜尋」有下列搜尋功能：

搜尋 說明

邊緣 搜尋具有使用者指定臨界值位準的邊緣 (上升或下降)。

突波 搜尋比指定寬度更窄 (或更寬) 的脈波，或是忽略比指定寬度更窄 (更寬) 的
突波。

寬度 搜尋 >、<、= 或 ≠ 使用者指定之脈波寬度的正脈波寬度或負脈波寬度。

設置&保持 搜尋使用者指定的設定和保持時間違反。

矮波 搜尋正脈波或負脈波，它可與第一個振幅臨界值交叉，但再度交叉第一個
臨界值之前，無法與第二個臨界值相交。搜尋所有矮波脈波或只搜尋期間
>、<、= 或 ≠ 使用者指定時間的矮波脈波。
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搜尋 說明

視窗 搜尋進出臨界值視窗的訊號。請使用「When Wider」(較寬時) 選項，以時
間來限定搜尋。或視其他波道的邏輯狀態而使用「When Logic」(邏輯時) 選
項。

樣式 搜尋多個波形間的邏輯樣式 (AND、OR、NAND 或 NOR)，每個輸入設定為
High (高)、Low (低) 或 Don't Care (無關)。當事件在 >、<、= 或 ≠ 使用者指
定時間為真、為假或有效時，進行搜尋。此外，您必須將其中一項輸入定
義為同步 (狀態) 搜尋的時脈。

轉換 搜尋 >、<、= 或 ≠ 使用者指定時間的上升和/或下降邊緣。

逾時 搜尋指定時間內沒有任何脈波。

狀態 當所有邏輯輸入值使選定的邏輯函數成為真或假且時脈輸入值變更狀態時，
進行搜尋。

DDR 讀取 搜尋 DDR 讀取脈衝。需要選項 DDRA。

DDR 寫入 搜尋 DDR 寫入脈衝。需要選項 DDRA。

DDR 讀取和寫入 搜尋 DDR 讀取和寫入脈衝。需要選項 DDRA。

匯流排 並列： 搜尋二進位或十六進位值。

I2C： 搜尋啟動、重複啟動、停止、遺失確認、位址、資料或位址和資料。

SPI： 搜尋 SS Active、MOSI、MISO 或 MOSI 與 MISO。

CAN： 搜尋圖框開始、圖框類型 (資料、遠端、錯誤、超載)、識別器 (標準
或延伸)、資料、識別器與資料、圖框結尾，或遺失確認、位元載滿錯誤。

RS-232、RS-422、RS-485、UART： 搜尋 Tx 開始位元、Rx 開始位元、Tx 封
包結束、Rx封包結束、Tx資料、Rx資料、Tx 同位錯誤，或Rx同位錯誤。

LIN：搜尋同步、識別器、資料、ID與資料、喚醒框格、睡眠框格、錯誤。

FlexRay： 搜尋圖框開始、圖框類型、識別器、週期計數、標題欄位、資
料、ID 與資料、圖框結尾、錯誤。

Ethernet：搜尋圖框開始、MAC 位址、Q 標籤控制資訊、MAC 長度/類型/資
料、IPv4Header、TCP 標頭、TCP/IPv4 用戶端資料、封包結尾和 FCS 錯誤。

PCIe：搜尋碼型、字元/符號、長命令設定錯誤和任意控制字元。

8b/10b：搜尋碼型、字元/符號、錯誤和任意控制字元。

MIPI：搜尋傳輸停止、開始/結束、匯流排轉向、逸出模式、警告、錯誤和
短/長封包。

MIL-STD-1553：搜尋同步、指令/狀態文字、資料、RT/IMG 時間和錯誤。

自訂：使用自訂解碼器搜尋。

USB：搜尋同步、重設、暫停、繼續、封包結束、Token (位址) 封包、資料
封包、信號交換封包、特殊封包、錯誤、碼型、字元/符號、長命令設定、
封包、LFPS、或任意控制字元。
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使用視覺搜尋
執行視覺搜尋所使用的執行設定和主要觸發相同。 視覺搜尋結果所顯示的標記，會使用有別於分析
搜尋標記的顏色。 請執行下列步驟設定視覺搜尋。

1. 設定 Pinpoint 觸發。 ( 請參閱
頁62，選擇觸發類型)

2. 設定視覺觸發。 (請參閱頁76，使
用視覺觸發進行觸發 (視覺觸發))

3. 按一下「Mark All Trigger Events in
Record」(標記記錄中所有觸發事
件)。

4. 視覺觸發區域會以藍色顯示。

5. 視覺搜尋區域會以綠色顯示。

6. 只有作用中的視覺搜尋區域才會
顯示。按下標記「Next」(下一個)
和「Prev」(上一個) 按鈕，將作用
中的區域移至其他視覺搜尋區域。

使用其他的「分析搜尋」控制視窗，
以控制或檢視視覺搜尋的結果。
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分析波形
本儀器提供了游標、自動測量、統計、長條圖、算術運算、頻譜分析和進階的通過∕失敗測試等功
能，以幫助您分析波形。本節將介紹分析波形的概念和程序。線上說明將提供詳細資訊。

進行自動測量
1. 選 取 Measure > Measurement

Setup...(測量>測量設定...)。

2. 選取您要測量的波道、算術運算
或參考波形。

3. 請使用這些索引標籤來選取 5 種
不同類別的測量。
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4. 若要移除所有量測值， 按一下
Clear All (清除全部)。

5. 若要移除多筆測量值，按一下並
拖曳來選擇 測量值，然後按一下
Clear Selected (清除所選測量值)。

您也可以直接在 Measure (測量) 功
能表選擇所選波形的測量值。 (請
參閱頁110，自動測量選項)

快速秘訣
透過 DPOJET 則可針對數位通道波形進行自動量測。僅可使用適用於數位波形的量測。在
MSO70000C/DX 儀器上，若要測量數位通道波形，請先使用 iCapture 將數位通道傳送至類比通道。
( 請參閱頁54，檢視數位波形的類比特性)

使用捲動模式時，您必須等到擷取停止之後，才可以看到測量值。

警告。 如果出現垂直裁剪，探棒頭則具有危險的電壓，但讀數格只會顯示低電壓。 如果出現垂直裁

剪的情況，儀器讀數格則會出現 符號。發生訊號垂直裁剪的自動振幅相關測量值，所產生的結果
將不精確。若儲存或匯出讓其他程式使用的波形被裁剪，也會導致不精確的振幅值。如果是裁剪數學
波形，則數學波形的振幅測量值並不會受到影響。
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自動測量選項
下表列出各種依類別的自動測量： 裁剪、時間、長條圖、通訊，或更多。 ( 請參閱頁108，進行自動
測量)

振幅測量值

測量 說明

振幅 整個波形或閘控區域的高值減去低值後，所得到的值。

高 在測量上升或下降時間這類需要用到高參考、中參考或低參考值的情況下，這個
值就會當作 100%使用。這個值可使用最小值∕最大值、或長條圖方法計算得出。
最小值∕最大值方法會使用實際找到的最大值。長條圖方法會使用實際找到最常
超過中點的值。這個值可由測量整個波形或閘控區域得到。

低 在測量上升或下降時間這類需要用到高參考、中參考或低參考值的情況下，這個
值就會當作 0% 使用。這個值可使用最小值∕最大值、或長條圖方法計算得出。
最小值∕最大值方法會使用實際找到的最小值。長條圖方法會使用實際找到最常
低於中點的值。這個值可由測量整個波形或閘控區域得到。

RMS 整個波形或閘控區域的真均方根電壓。

AC RMS 測量區域上的真「均方根」電壓。

最大 最大正峰值電壓。最大值可由測量整個波形或閘選區域得到。

最小 最大負峰值電壓。最小值可由測量整個波形或閘選區域得到。

峰對峰 整個波形或閘控區域中，最大和最小振幅的絕對差值。

週期均方根 波形第一個週期或是閘控區域第一個週期的真均方根電壓。

正過激 這是測量整個波形或閘控區域所得的測量值。可由下列運算式得出：正過激量 =
((最大值 – 高值) / 幅度) x 100%。

負過激 這是測量整個波形或閘控區域所得的測量值。可由下列運算式得出：負過激量 =
((低值 – 最小值) / 幅度) x 100%。

平均 整個波形或閘控區域的代數平均值。

週期平均 波形第一個週期或是閘控區域第一個週期的代數平均值。

時間測量值

測量 說明

上升時間 波形或閘控區域中第一個脈波上升邊緣，從最後值的低參考值 (預設 = 10%) 爬升
到高參考值 (預設 = 90%) 所需要的時間。

下降時間 波形或閘控區域中第一個脈波下降邊緣，從最後值的高參考值 (預設 = 90%) 下降
到低參考值 (預設 = 10%) 所需要的時間。

正脈波寬 正脈波中參考 (預設 50%) 振幅點之間的相隔距離 (時間)。測量波形或閘控區域的
第一個脈波，就可知道測量值。

負脈波寬 負脈波中參考 (預設 50%) 振幅點之間的相隔距離 (時間)。測量波形或閘控區域的
第一個脈波，就可知道測量值。

正工作週期 正脈波寬度和訊號週期的比率，以百分比例表示。測量波形或閘控區域的第一個
週期，就可知道工作週期。

負工作週期 負脈波寬度和訊號週期的比率，以百分比表示。測量波形或閘控區域的第一個週
期，就可知道工作週期。
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時間測量值 （待續）

測量 說明

週期 完成波形或閘控區域中第一個週期所需要的時間。週期是頻率的倒數；以秒鐘為
測量單位。

頻率 波形或閘控區域中第一個週期的頻率。頻率是週期的倒數；它的測量單位是 Hertz
(Hz)，1 個 Hz 指每秒鐘一個週期。

延遲 兩個不同波形中參考 (預設 50%) 振幅點之間的相距時間。

其他測量值

測量 說明

面積 整個波形或閘控區域的面積。單位為伏特-秒。測量基線以上的面積是正值；測
量基線以下的面積是負值。

週期面積 這是指波形第一個週期或閘控區域第一個週期的區域面積。單位為伏特-秒。測量
高於一般參考點面積會得到正值，測量低於一般參考點面積會得到負值。

相位 特定波形超前、或落後另一個波形的時間長度，以度來表示。這時 360° 包含整個
波形週期。

爆衝寬度 爆衝 (一連串暫態事件) 期間時間，可測量整個波形或閘控區域得知。

長條圖測量值

測量 說明

Wfm Ct 顯示構成長條圖的波形數目。

矩形中的命中數 顯示出現在長條圖矩形中∕上的點數。

峰命中數 顯示長條圖中最大集區出現的點數目。

中值 顯示長條圖矩形的中間點。位在長條圖矩形之內和之上的所有擷取點值中，有一
半小於這個值，而另一半大於這個值。

最大 顯示垂直長條圖中非零值 bin 的最高電壓，或水平長條圖中最右邊非零值 bin 的
時間。

最小 顯示垂直長條圖中非零值 bin 的最低電壓，或水平長條圖中最左邊非零值 bin 的
時間。

峰對峰 顯示長條圖的峰對峰值。垂直長條圖顯示最高非零值 bin 的電壓減去最低非零值
bin 的電壓。水平長條圖顯示最右邊非零值 bin 的時間減去最左邊非零值 bin 的時
間。

平均 測量長條圖矩形內∕上所有擷取點的平均值。

標準差 測量長條圖矩形內∕上所有擷取點的標準偏差值 (均方根 (RMS) 偏差值)。

平均 ±1 標準差 顯示與長條圖平均不超過 1 個標準差的擷取點百分比。

平均 ±2 標準差 顯示與長條圖平均不超過 2 個標準差的擷取點百分比。

平均 ±3 標準差 顯示與長條圖平均不超過 3 個標準差的擷取點百分比。
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通訊測量值

測量 說明

消光比 眼球頂部至基準線的比例。這項測量只能用於波形資料庫，或波形資料庫模式下
已儲存的參考波形。

消光比 % 眼球頂部至基準線的比例。單位為百分比例。這項測量只能用於波形資料庫，或
波形資料庫模式下已儲存的參考波形。

消光比 (dB) 眼球頂部至基準線的比例。單位為分貝。這項測量只能用於波形資料庫，或波形
資料庫模式下已儲存的參考波形。

眼高度 測量眼高度。單位為伏特。

眼寬度 測量眼寬度。單位為秒鐘。

眼頂點 用於測量消光比的頂部值。

眼基準線 用於消光比量測中的基準值。

交叉 % 眼狀圖交叉點。以眼高度的百分比表示。

抖動 P-P 目前水平單位中邊緣抖動的峰對峰值。

抖動 RMS 目前水平單位中邊緣抖動的 RMS 值。

抖動 (6 Sigma) 目前水平單位中邊緣抖動 RMS 值的 6 倍值。

雜訊 P-P 指定訊號頂部或基準的雜訊峰對峰值。

雜訊 RMS 指定訊號頂部或基準的 RMS 值。

S/N 比例 指定訊號頂部或基準的訊號振幅和雜訊比例。

週期失真 在中參考所測量第一個眼狀圖交叉的峰對峰時序變化。單位為眼球週期的百分比
例。

Q 係數 眼球尺寸至雜訊比例。
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自訂自動測量
您可以使用範圍、修改測量統計、或是調整測量參考位準，來自訂自動測量。

範圍

使用範圍來限制測量於波形的特定部
分。

1. 選取 Measure > Gating > Gating (測
量>範圍>範圍) ...。

2. 請執行下列動作之一來指定範圍：

按一下Cursor (游標)，將閘控區
域設定為游標間的區域。

按一下Zoom (1-4) (縮放 (1-4)，
將閘控區域設定為 Zoom (1-4)
( 縮放 (1-4)) 方格圖。
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統計

統計功能可自動啟動測量。統計值可
顯示測量的穩定性。

1. 如果要改變顯示的統計值，請選取
Measure > Statistics (測量>統計)，再
選取Mean (平均值)或All (全部)。
(全部 選項包括了最小值、最大
值、平均值、標準差和總數。)

2. 如果要關閉統計功能，請選取Off
(關閉)。

注意。 將游標置於測量上可顯示測
量的較高解析度版本。

快照

如果要一次查看全部有效測量，請選
取Measure > Snapshot (測量>快照)。

注意。 如果測量的設定無效，測量
結果顯示 3 個問號。

若要快照一般測量或通訊測量，請選
取 General (一般) 或 Comm (通訊)。
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註解測量

1. 若要註解測量，請從Measurements
setup (測量設定) 控制視窗選取
Annotation (註解)。從下拉式選單
選擇測量以進行註解。

2. 若要選擇測量註解的 詳細資訊數
量，請選取 Measure > Annotation >
Standard (測量 > 註解 > 標準) 或
Detailed (詳細資料)。
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參考位準

參考位準會決定和時間相關的實際測
量結果。

1. 選 取 Measure > Reference Lev-
els...( 測量>參考位準...)。

2. 將測量參考水平調整到不同的相
對值或絕對值。

使用高、低參考來計算上升和
下降時間。預設的高參考是
90%，低參考是 10%。

Mid (中) 參考主要用於邊緣之
間的測量，例如脈波寬度。預
設水平為 50%。

Mid2 (中2)參考則用於延遲或相
位測量所指定的第二個波形。
預設水平為 50%。

快速秘訣
為確保精準的雜訊值，請務必在測量眼狀圖 (Eye) 訊號時，移至「Reference Levels Setup」(參考位準
設定) 功能表，並將訊號類型設定成眼狀圖 (Eye) 訊號。
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進行游標測量
使用游標以手動測量擷取的資料。

1. 按下Cursors (游標)。

注意。 如果已啟用游標，但多功能
旋鈕讀數未與「Position」(位置) 控
制項連接，請按下「Cursors」(游標)
按鈕將控制項與讀數連接。 再按一
次「Cursors」(游標) 按鈕可將游標關
閉。

MSO/DPO70000DX、MSO/DPO70000C 和 DPO7000C 系列

MSO5000 和 DPO5000 系列

2. 選取 Cursor Source (游標來源)。

3. 請選取下列游標類型之一：

H Bars (水平線條)：可測量振幅
(通常單位為伏特或安培)

V Bars (垂直線條)：可測量水平
參數 (時間)

Waveform (波形) 游標和 Screen
(螢幕) 游標可以同時測量垂
直和水平參數。波形游標可附
加到波型中。而螢幕游標只能
浮動在波形上，無法附加到其
中。
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4. 如果要在二種波形之間進行測量，
請選取 Waveform (波形)，再一一
選取游標的波形來源。

5. 請 選 取 Cursors > Cursor Posi-
tion...( 游標>游標位置...)，再使用
多用途旋鈕來調整游標位置。

6. 於畫面讀取游標測量結果。

快速秘訣
請使用 Cursor Track (游標追蹤)模式以設定游標串聯地移動。請使用 Cursor Independent (游標獨立)模
式以設定游標個別地移動。

如果您使用縮放方格圖，可以直接放置游標在特定波形點以便進行精確測量。

也可用游標按一下並拖曳它們到新的位置。

若要將游標移到畫面中央，請按 Move Cursors to Center (將游標移到中央)。

您可以選取實線游標或虛線游標。

Vertical (垂直) 游標會測量從觸發點到垂直游標的時間。
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設定長條圖
您可以顯示垂直 (電壓) 或水平 (時間) 長條圖。使用長條圖測量，可以在特定軸線上取得波形區段的
統計測量資料。

1. 按一下指標並拖曳通過您希望長
條圖涵蓋的波形區段。如要設定
水平長條圖，則使矩形的寬度長
於高度。

2. 從捷徑功能表中選取Histogram Ver-
tical (長條圖垂直)或Histogram Hor-
izontal (長條圖水平)。

3. 在方格圖的頂點 (可檢視水平長條
圖) 或左邊緣檢視長條圖 (可檢視
垂直長條圖)。
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4. 如果要調整長條圖刻度、或長
條圖矩形的尺寸和位置，請選取
Measure > Waveform Histograms (測
量>波形長條圖)，再使用Histogram
Setup (長條圖設定) 控制視窗。

5. 您也可以在長條圖資料上執行自
動化測量。 ( 請參閱頁108，進行
自動測量)

快速秘訣
請使用垂直長條圖來測量訊號雜訊；使用水平長條圖來測量訊號抖動。

按一下並拖曳捷徑功能表，便可關閉長條圖顯示。
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使用算術運算波形
建立算術運算波形，支持您對波道和參考波形的分析。您可以結合並轉換來源波形和其他資料到算術
運算波形，衍生在應用時所需要的資料檢視。

使用下列程序來取得預先定義的算術運算式。

1. 選取 Math > Math Setup...(算術運算
>算術運算設定...)。

2. 選擇預先定義的算術運算式之一。

使用下列程序來建立進階的算術運算波形運算式。

1. 選取 Math > Math Setup...(算術運算
>算術運算設定...)。

2. 按一下 Editor (編輯器)。
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3. 使用來源、運算子、常數、測量
值、變數以及函數來建立算術運
算波形運算式。

4. 當您定義出滿意的運算式之後，
請按一下 Apply (套用)。

5. 如果要新增個人的濾波器，請按
一下 Filter (濾波器) 索引標籤。按
一下 Load (載入)。

6. 按兩下所要使用濾波器的資料夾。
按兩下您想使用的濾波器。
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7. 使用所選定的濾波器來 建立個人
的算術運算式。

8. 當您定義出滿意的運算式之後，
請按一下 Apply (套用)。

快速秘訣
連按兩下算術運算式可開啟算術運算方程式編輯器。

如果來源不是有效資料，則無法套用算術運算的定義。

算術運算波形可從類比波道、參考、算術運算來源波形、及測量值建立。

數位波道在算術運算波形中無效。不過 iCapture 波形在算術運算波形中有效。

使用「Digital Properties」(數位內容) 來設定類比波道的數位臨界值。

算術運算波形也可用通道波形的相同方式，進行測量。

算術運算波形可從算術運算式中的原始資料，衍生其水平刻度和位置。調整來源波形的控制項也
可以調整算術運算式。

如果未勾選「Autoscale」(自動調整刻度)，開啟數學波形或變更數學方程式時，將不會計算垂直刻
度和位置。

您可以使用 MultiView Zoom 來放大算術運算波形；請使用滑鼠來設定縮放區域的位置。

如需更多有關任意算術濾波器的資訊，請參閱 線上說明。
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使用頻譜分析
使用下列程序來取得預先定義的頻譜算術運算式。如需更多資訊，請參閱線上說明。

1. 選取 Math > Math Setup...(算術運算
>算術運算設定...)。

2. 選擇預先定義的頻譜算術運算式
之一。

3. 按一下 Basic (基本)。

4. 按一下 Resolution BW (解析度頻寬)
或 Frequency Span (頻展)，並使用
數字鍵盤或多用途旋鈕來調整頻
譜顯示。

注意。 解析度 BW 和頻率頻展區只
能在手動水平模式中調整。
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使用下列程序來建立進階的頻譜算術運算式。

1. 選取Math > Advanced Spectral...(算
術運算>進階頻譜...)。

2. 選取您要定義的算術運算波形。

3. 按一下您要建立的頻譜波形類型。
如果要重新定義波形，請按一下
Clear (清除)。

4. 選取來源波形。

5. 使用 Spectral Setup (頻譜設定)控制
視窗及多用途旋鈕，來調整頻譜
波形。

MSO/DPO70000DX、MSO/DPO70000C 和 DPO7000C 系列
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MSO5000 和 DPO5000 系列

6. 您可以同時檢視時域和頻域的波
形。

您也可以使用Gating (範圍)，僅選
擇頻譜分析的一部份時域波形。
( 請參閱頁113，範圍)

快速秘訣
頻譜算術運算波形的來源須為波道或其他算術運算波形。

使用短記錄長度可提供更快的儀器響應。

使用長記錄長度可降低與訊號相關的雜訊，並提高頻率解析度。

不同的視窗功能會在頻譜中產生不同的濾波器響應波形，而且會產生不同的解析度頻寬。如需更
多資訊，請參閱線上說明。

解析度頻寬 (RBW) 直接控制閘道寬度。因此，當您調整此控制項時，時域閘道標記也會隨著移動。

您可以在頻譜中顯示實際資料或假想資料的線性振幅。這項功能在您離線狀態處理頻譜，並將其
轉換回時域軌跡時特別有用。

126 MSO/DPO70000DX、MSO/DPO70000C、DPO7000C 和 MSO/DPO5000 系列使用者手冊



分析波形

使用串列錯誤偵測器
串列錯誤偵測器需選用 ERRDT。 示波器的「錯誤偵測器」會執行與 BERT 類似的位元、圖框、符號和
字元測試。 此偵測器不僅具有計算錯誤次數和錯誤率的優勢，而且也會顯示訊號中發生錯誤的位置，
並且讓您將探棒連接至其他通道，以針對錯誤 (例如串音) 的來源進行除錯。

錯誤偵測器通常會與 TekExpress 軟體應用程式一起使用，進行接收器和邊際測試。

錯誤偵測器具有內建的預設設定，可涵蓋大多數的常用案例。 您可以修改這些設定，並將其儲存為自
訂設定檔供稍後叫出。 內含的取樣任意波形產生器 (AWG) 設定檔適用於各種 SATA Gen3 及 USB3 訊
號。 這些檔案可讓您輕鬆驗證錯誤偵測器的操作是否正確，而且可針對測試中裝置 (DUT) 進行測試。

若要使用串列錯誤偵測器，請依照下列步驟執行：

1. 選取「Analyze > Serial Error Detec-
tor」(分析 > 串列錯誤偵測器) 以
顯示錯誤偵測器控制視窗。

2. 在「Preset Setting」(預設設定) 下
拉式清單中選取一項設定，然後
按下「Apply」(套用)。

如果不需要「自訂設定」，請繼續進行步驟 13。
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3. 當您選取「Custom_Setup」時，
螢幕上會顯示其他控制項，因此
您可以瀏覽設定檔。 一般的概
念是從接近您要的設定檔開始、
使用 UI 指定想要設定，然後儲
存結果。 當您在檔案名稱文字
控制項中輸入新檔案名稱時，按
下「Enter」(輸入) 使儀器接受您
編輯的變更。 接著按下「Save」
(儲存) 按鈕，將設定儲存至檔
案。 若要叫出設定檔，請瀏覽至
您要的檔案，然後按下「Open」
(開啟)。 錯誤偵測器設定檔的
預 設 位 置 為 C:\Users\Public\Tek-
tronix\TekScope\ErrorDetector。

4. 選取「Setup」(設定) 索引標籤。

5. 在「Source Setup」 (來源設定)
索引標籤中，從下拉式清單選
取「Serial Bus」(串列匯流排)、
「Data Rate」(資料速率) 和訊號
「Source」(來源)。

6. 按一下「Error Detection」(錯誤偵
測)選項按鈕，針對您想要的錯誤
類型進行偵測。

「Advanced」(進階)按鈕可開啟「Ad-
vanced Settings」(進階設定) 視窗。

進階設定視窗提供您必須變更才能進
行特殊設定的參數控制項。 這些數
值的預設設定適用於大部分的裝置。

7. 按一下「On」(開啟)或「Off」(關
閉)，可開啟或關閉展頻時脈 (SSC
追蹤)。

SSC 預設為開啟。
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8. 若要忽略對齊基元，請選取「Ig-
nore Align Primitives」(忽略對齊基
元)選項按鈕，然後使用數字鍵盤
或鍵盤來指定指定基元。

對齊基元會由 DUT 插入訊號以進行
定步 (防止傳輸器使接收器溢位)。

9. 使用數字鍵盤或鍵盤輸入「Maxi-
mum consecutive ALIGNs」(最大連
續對齊)。

最大連續對齊是特定裝置的設計參
數，代表允許的連續對齊數量。

測試樣式設定可控制訊號測試樣式長度並提供同步樣式的說明。 這些常是最困難的設定，因為使用
者必須具備訊號的知識。 樣式長度是訊號產生器或 AWG 傳送至 DUT 或示波器的位元數目。 同步樣
式是錯誤偵測器在訊號中使用的 10、20、30 或 40 位元特殊樣式，可將訊號和擷取的比較樣式對齊。
「Advanced」(進階) 核取方塊可讓您個別設定每個不對等的「同步樣式」符號。 X 代表無關。 「預設
設定」可設定這些參數，讓一般案例的工作更容易進行。

10. 在「Test Pattern」(測試樣式) 索
引標籤中，指定「Sync Pattern」
(同步樣式)、「Sync Pattern Polar-
ity」(同步樣式極性) 和「Pattern
Length」(樣式長度)。

11. 在「Stop Condition」(停止條件)索
引標籤中，選取「Stop When」(停
止條件)條件。您可以手動停止、
在達到預設計數或指定時間後停
止，或是發生錯誤時停止。

注意。 進行位元計數測試時，請使
用較大的數字。進行 6 Gb/s、60百萬
位元測試時，請設定 10 秒鐘。

12. 選取並設定符合停止條件時要執
行的動作。 使用這些動作，即可
保留示波器所擷取的資訊。 您必
須設定電子郵件地址和 SMTP 伺
服器，才能讓「Send E-mail」(傳
送電子郵件) 運作。
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13. 按下「Sync」(同步)按鈕，並等候
出現「Not Counting」(未計算) 的
狀態 (約 6 秒鐘)。 視訊號品質而
定，您可能需要再按一次「Sync」
(同步) 按鈕。

「Sync」(同步) 可讓示波器與訊號同
步。

「No Signal」(無訊號) 的狀態代表示
波器無法偵測訊號。您可能必須開啟
訊號產生器或 AWG的輸出。 需要已
知樣式長度、同步樣式或對齊字元的
位元測試可能會出現「No Sync」(未
同步) 的狀態。

14. 如果有「Learn」(學習) 按鈕，請
按下此按鈕。 「Learn」(學習) 僅
適用於部份的位元錯誤測試。 圖
框、符號和字元測試不需要學習
操作。 學習可發現訊號中重複的
樣式，並將重複的樣式儲存至系
統記憶體並與訊號進行比較，以
判斷訊號中的錯誤。 當訊號儲存
至記憶體之後會保留一段時間，
直到後續執行學習操作為止，因
此您不需要在每次進行錯誤測試
時使用「Learn」(學習) 按鈕。

15. 按下「Run」(執行) 按鈕啟動錯誤
偵測器。

如 有 必 要 ， 您 隨 時 都 可 以 按 下
「Stop」(停止) 或「Reset」(重設)。
停止之後，您可以再按一次「Run」
(執行)。

「Run」(執行) 會啟動錯誤偵測器進
行錯誤測試。

16. 選取「Results」(結果)索引標籤，
可查看執行錯誤偵測器的結果。

注意。 如果您按下「Reset」(重設)，
或是中斷然後重新連接訊號，串列錯
誤偵測器就會自動重新同步，並將所
有的計數重設為零。
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如果您使用其中一種提供的 AWG 訊號樣式，可以按下 AWG 上的「Force Event」(強制事件) 按鈕
讓訊號中產生錯誤，以驗證錯誤偵測器的操作。 這些 AWG 設定檔在 Win7 中位於 C:\User\Public\Tek-
tronix\Tekscope\ErrorDetector\AWG 目錄

此外，您也可以利用中斷然後重新連接訊號的方式來驗證操作。 雖然中斷連接時會有大量錯誤，但重
新連接訊號之後，錯誤偵測器會重新同步處理訊號、清除錯誤計數和錯誤率，然後繼續進行測試。

17. 按下「Error Detector」(錯誤偵測
器)的「Off」(關閉)按鈕，即可結
束錯誤偵測工作階段。 此處將出
現跳出功能表，表示觸發已變更
為「Edge」(邊緣)。

一般的啟動程序可歸納為 a) 選取預設設定；b) 按下「Sync」(同步)；c) 按下「Learn」(學習) (如果有此
按鈕)；以及 d) 按下「Run」(執行)。 同步操作可以讓示波器與訊號同步、學習操作可將訊號樣式擷取
至示波器記憶體，而執行操作可啟動測試錯誤的錯誤偵測器。 請注意，學習操作僅適用於部分的位元
錯誤測試。 請記住，圖框、符號和字元錯誤測試不需要學習操作。

串列錯誤偵測器可搭配多種纜線排列方式使用。當需要學習操作才能將訊號測試樣式擷取至錯誤偵測
器記憶體時，第一種纜線設定就特別適合 SATA、PCIe 和一般的 8b/10b 位元測試。不過，如果您要驗
證錯誤偵測器的操作，也可以使用這種相同的纜線排列方式。

18. 如下列圖解連接纜線，可進行
SATA、PCIe 和一般位元測試的學
習操作。

19. 完成學習操作後，現在您可以在
如下圖所示的訊號產生器和錯誤
偵測器之間插入 DUT。

將 DUT 插入訊號產生器和串列錯誤
偵測器間之後，您只要按下「Sync」
(同步) 和「Run」(執行) 按鈕即可執
行錯誤偵測器，因為學習操作已經在
上一個步驟完成。如果您執行另一次
的學習操作，可能會學習到 DUT 所
產生的錯誤。
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20. 如果要避免在學習操作之後重新
排列纜線，可以分割訊號產生器
的輸出，將某個分支放到錯誤偵
測器，並將另一個放到 DUT。 此
案例已完成 Ch1 的學習操作，但
實際的錯誤偵測卻發生在 Ch2。
您可以調整訊號產生器的振幅，
以說明因分割訊號造成的損失。
這種方法可行，是因為錯誤偵測
器的學習操作會將訊號測試樣式
儲存至非通道的特定記憶體。

21. 當錯誤偵測器由使用者介面驅動
時，就會盡量使用匯流排觸發，因
此匯流排解碼會自動啟用。 「解
碼」會使用紅色醒目提示代表訊
號中錯誤的位置 (如下列的螢幕參
數所示)。您可以使用其他的示波
器通道同時探測其他訊號，以找
出錯誤的原因。
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使用波罩測試
序列 通訊波罩測試 (Serial Communications Mask Testing，配合 MTM 或是 MTH 選項)，可用來比較 訊號
和預先定義的範本或波罩。通過此項測試的訊號， 必將座落於波罩定義的區段之外。一般來說， 這
些波罩是由 ANSI 這類標準協會完成定義。如果要執行波罩測試，請執行下列動作：

1. 選取「Mask > Source...」(遮罩 >來
源...)。

2. 選取訊號來源。

3. 按一下Masks (波罩)索引標籤。

4. 選取特定類型和標準類型。
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5. 請按一下「Config」(組態) 按鈕，
來存取「Mask Configuration」(遮
罩組態) 控制視窗。您可在其中
調整遮罩和違反的顯示方式，及
「Mask Autoset」(遮罩自動設定)
和「Autofit」(自動適應)的組態方
式。

6. 按一下 Masks (波罩)，便可返回
Mask Setup (波罩設定) 控制視窗。

7. 按一下 Lock Mask to Wfm (將遮罩
鎖到波形) 「On」(開啟)，便可追
蹤水平或垂直設定的波罩變更。

8. 切換成Hit Count (計算擊數)「On」
(開啟)，便可在波罩測試期間反白
選取違反區段。

9. 按一下 Autoset (自動設定)，便可
自動根據輸入訊號特性將波形對
齊波罩。

10. 切換成 Autofit (自動適應) 「On」
(開啟)，便可自動在每次擷取之後
重新設定波形位置，以便盡量減
少命中次數。

11. 按一下 Tolerance (容許度) 索引標
籤，再設定容許度。

大於 0% 的容許度設定值會提高
波罩測試的通過難度。若是小於
0%，則表示測試比較容易通過。

如果您要依照標準指定方式來使
用波罩，請使用 0%。改變這個百
分比例便可進行邊際測試。
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12. 選取 Pass/Fail Setup (通過/失敗設
定) 索引標籤，設定通過∕失敗參
數。(如果是使用 WfmDB 擷取模
式，波形數目索引標籤將變成取
樣。)

13. 選取 Pass/Fail Test Notifications (通
過/失敗測試通知)。

14. 選取您要測試的波形極性。

15. 切換成 Repeat (重複) 「On」(開
啟)，便可持續執行波罩測試。

16. 選取當測試完成時您所希望收到
的通知。

17. 按一下 Pass/Fail Results (通過/失敗
結果)索引標籤可檢視測試結果。

18. 切換成 Pass/Fail Test (通過/失敗測
試) 「On」(開啟)可開始波罩測
試。

19. 按一下 Reset (重置) 可重置總數，
並清除所有違反。

快速秘訣
波罩測試不適用於數位波道波形。

如果訊號沒有在波罩範圍內，請啟用 Autoset (自動設定) 來將波形置入波罩中間。
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使用極限測試
選用性的極限測試可比較作用中訊號與波模波形。使用良好的訊號來建立波模波形並與作用中訊號做
比較，以進行通過/失敗測試。

1. 選取「Masks > Limit Test Setup... 」
(遮罩 > 極限測試設定...)。

2. 若要建立波模，請選取 Source
(來源)、Destination (目的地) 和
Tolerances (容許度)。可使用多功
能旋鈕來調整容許度。容許度可
指定訊號的允許邊際，超過後極
限測試便失敗。

3. 按一下Save (儲存)。您可以建立
並儲存多個波模供日後使用。

4. 選取來源波形以和波模比較。

5. 選取波模和來源波形做比較 (通
常是您在步驟 3 建立的波模)。
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6. 按一下 Failure Notification (失敗通
知)，可設定失敗通知。

7. 選取失敗通知，按一下 Setup (設
定)，回到設定控制視窗。

8. 按一下 Lock Template to Waveform
(將波模鎖定於波形)的「On」(開
啟)，將波模的垂直刻度或位置鎖
於來源波形的垂直刻度或位置。

9. 按一下Highlight Hits (反白擊數)的
「On」(開啟)，以不同顏色顯示
落於波模外部的點。

10. 切換到 Limit Test (極限測試) 的
「On」(開啟)，啟動測試。

11. 按一下 Reset (重設)，可清除所有
違反，重設測設。

快速秘訣
您可以使用作用中或已儲存的波形來建立極限測試波模。

使用平均擷取模式，可建立更平緩的波模波形。

使用「包封」擷取模式，可建立允許偶發過激量的波模。
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MyScope
您可以透過 MyScope，建立僅包含一般常用控制項的自訂控制視窗。將個人使用的控制項放入自訂的
控制視窗之後，您就不用在幾個控制視窗之間切換。

本節將介紹建立和使用 MyScope 控制視窗的程序。線上說明將提供詳細資訊。

建立新的 MyScope 控制視窗
1. 選取 MyScope > New Control Win-

dow...(MyScope>新增控制視窗...)。

2. 按一下 + 來展開類別。每個類別
都會包含可新增到 MyScope 控制
視窗的控制項。這些類別對應功
能表列，以協助您找到通常使用
的控制項。
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3. 按一下控制項來預覽。

4. 按兩下控制項，或是按一下 + 來
展開控制項清單。(如果這時沒有
顯示 +，表示該控制項目無法更進
一步自訂。)
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5. 清除核取方塊，移除任何您不希
望包含在該控制項中的元件。

6. 按一下控制項，並將它拖曳到
MyScope 控制視窗。當您釋放滑
鼠時，該控制項就會嵌入最靠近
的方格位置。您可以按一下並拖
曳該控制項，便可在 MyScope 控
制視窗中改變控制項的位置。
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7. 按一下 New Tab (新增索引標籤)
以在 MyScope 控制視窗中新增索
引標籤。您最多可有 六個索引標
籤。

8. 如果要重新命名索引標籤，請執
行下列動作之一：

按一下Rename Tab (重新命名索
引標籤)

按兩下索引標籤，再輸入新名
稱。

9. 按一下User Pref...(使用者偏好...)，
指定要載入MyScope控制視窗的使
用者偏好。

10. 如果要刪除控制項，請執行下列
動作之一：

選取索引標籤，再按一下Delete
( 刪除)。這樣就可刪除索引標
籤和其中所有的控制項。

選取控制項，再按一下 Delete
( 刪除)。如此只會刪除選取的
控制項。

11. 按一下 Save (儲存)，然後輸入
MyScope 控制視窗的名稱，或是
使用預設名稱。

快速秘訣
如果要重新設定控制項，請按一下該項，並將其拖回到預覽視窗。接著選取或清除核取方塊，以
便包括或移除控制項中的元件。

如果要改變索引標籤的順序，請按一下索引標籤，再將它拖曳到新位置。

如果要刪除控制項，請按一下該項， 再將它拖曳到螢幕的上半部 (拉離 MyScope 控制視窗)。
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使用 MyScope 控制視窗
如果要開啟先前所定義的 MyScope 控制視窗，請執行下列動作：

1. 選取 MyScope > Open Control Win-
dow...(MyScope>開啟控制視窗...)，
或選取5個最常使用的MyScope視
窗之一。

2. 選取您要使用的 MyScope 控制視
窗，並按一下 Open (開啟)。

如果要顯示作用中的 MyScope 控制視窗，請執行下列動作：

1. 選取MyScope > Current...(MyScope>
目前...)，或於工具列模式中按一
下 MyScope。(即使 MyScope 控制
視窗並未顯示，它還是有在持續
作用。)
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如果要編輯 MyScope 控制視窗，請執行下列動作：

1. 選取 MyScope > Edit Control Win-
dow...(MyScope>編輯控制視窗...)。

2. 選取您要編輯的控制視窗，並按
一下 Open (開啟)。

快速秘訣
有些控制項在 MyScope 控制視窗中，會執行與它在標準控制視窗中的不同功能。如需詳細資訊，
請參閱線上說明。

您可以將MyScope 控制視窗 (.tcw檔案)複製到其他MSO/DPO70000DX、MSO/DPO70000C、DPO7000C
和 MSO/DPO5000 系列儀器。
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儲存和叫出資訊
本節將介紹從您的儀器儲存和叫出螢幕捕捉及設定、儲存測量值、使用剪貼簿和列印等程序。線上說
明將提供詳細資訊。

儲存螢幕捕捉
1. 選取 File > Save (檔案>儲存)，或

是 Save As > Screen Capture...(另存
新檔>螢幕捕捉...)。

2. 按一下「Options...」(選項...) 以設
定「Palette」(調色盤)、「View」
( 檢視 )、「 Image 」 ( 影像 ) 或
「Screen Capture Format」(螢幕捕
捉格式)等選項；否則請跳至步驟
3。
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3. 選取要儲存該螢幕捕捉的位置。

4. 輸入螢幕捕捉的名稱，或是使用
預設名稱，接著選取檔案類型。

5. 按一下 Save (儲存)。

快速秘訣
如果要快速儲存多個螢幕捕捉，請選取Set Front Panel Print Button to Save (設定前面板列印按鈕成儲
存)，再按一下 Save (儲存)。這樣一來，您只要按下前面板的 Print (列印) 按鈕，就可以儲存螢幕捕
捉。

儲存波形

1. 如果要儲存波形，請選取 File >
Save (檔案>儲存)，或是 Save As >
Waveform...(另存新檔>波形...)。

2. 按一下「Waveform」(波形)。

3. 按一下「Options...」(選項...) 以指
定「Waveform Data Range」(波形資
料範圍)、「FastFrame Data Range」
(快速圖框資料範圍)、「Waveform
Detai」(波形細節)、「Data Desti-
nation」(資料目的地)、「Source」
(來源) 或是「Data Ordering」(資料
順序)；否則請跳至步驟 4。
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4. 選取 Source (來源)。

5. 您可以將波形另存成儀器記憶體的
參考波形，或是另存成Windows目
錄中的 .wfm 檔案。如果要將波形
另存成參考波形，請選取Ref 1–4
(參考 1–4)。如果要另存成 .wfm
檔案，請選取您要儲存該波形的
位置。

6. 如果您要將波形儲存成 .wfm 檔
案，請輸入檔案名稱，或是使用
預設名稱。

7. 按一下 Save (儲存)。

快速秘訣
選取「Auto-increment file name」(自動遞增檔名) 可直接儲存相似波形，而不需要每次都重新輸入完
整檔名。

如果要快速儲存多個波形，請選取 Set Front Panel Print Button to Save (設定前面板列印按鈕成儲存)，
再按一下 Save (儲存)。這樣一來，您只需按下前面板的 Print (列印) 按鈕即可儲存波形。
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叫出波形
1. 選取 File > Recall...(檔案>叫出...)。

2. 按一下 Waveform (波形)。

3. 選取您要叫出波形的 Destination
( 目的地)。

4. 選取要叫出的波形。

5. 按一下Recall (叫出)。按一下Recall
(叫出) 便可開啟參考波形，並啟
動 Reference Waveform (參考波形)
控制視窗。

6. 使用控制項來調整參考波形。您也
可以選取 File > Reference Waveform
Controls...(檔案>參考波形控制...)
來存取Reference Waveform (參考波
形) 控制視窗。
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快速秘訣
您可以儲存多種不同的檔案類型，但是您只可以叫出設定 (*.set) 檔案和波形 (*.wfm) 檔案。

儲存數位波形
在 MSO 系列儀器上，您可以使用 .csv 格式檔案儲存數位波形。

1. 若要儲存數位波形，請選取「File
> Save」(檔案>儲存)，或是「Save
As > Digitals」(另存新檔 >數位)。

2. 按一下「Digitals」(數位)。

3. 您只可以在 Windows 目錄中將數
位波形儲存為 .csv 檔。若要儲存
為 .csv 檔，請選取要儲存波形的
位置。

4. 輸入檔案名稱，或是使用預設名
稱。

5. 按一下「Save」(儲存)。
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儲存儀器設定
1. 選取 File > Save (檔案>儲存)，

或 Save As > Setup...(另存新檔>設
定...)。

2. 按一下「Setup」(設定)。

3. 選取要儲存該設定的位置。您可
以將設定儲存到儀器記憶體提供
的十個設定儲存位置其中之一，
或是另存成 Windows 目錄中的 .set
檔案。

4. 輸入檔案名稱或是使用預設名稱。
使用跳出鍵盤輸入要存到儀器記
憶體中的設定檔案名稱。

5. 按一下 Save (儲存)。

快速秘訣
如果有啟用觸控顯示螢幕，請使用跳出數字鍵盤為設定加上便於識別的標籤。

使用「Auto-increment file name」(自動遞增檔名) 可直接儲存相似檔案，而不需要每次都重新輸入完
整檔名。

如果要快速儲存多個設定，請選取 Set Front Panel Print Button to Save (設定前面板列印按鈕成儲存)，
再按一下 Save (儲存)。這樣一來，您只需按下前面板的 Print (列印) 按鈕即可儲存設定。
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叫出儀器設定
1. 選取 File > Recall...(檔案>叫出...)。

2. 按一下 Setup (設定)。

3. 選取您要叫出的設定檔案。您可
以從儀器記憶體十個位置其中之
中或是從 Windows 目錄，叫出所
需的設定檔案。

若要保留目前的偏移校正設定，
按一下「Don't recall deskew values」
(不叫出偏移校正值)。

4. 按一下 Recall (叫出)。

快速秘訣
您可以叫出儲存在磁碟上的任何設定，然後將其存到內部設定儲存位置以便更快速存取。
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儲存測量值
1. 選取「File > Save」(檔案 >儲存)，

或「Save As > Measurement...」(另
存新檔 > 測量...)。

2. 按一下「Options...」(選項...) 以指
定「Displayed Measurements」(已顯
示的測量值)、「Measurement Snap-
shot」(測量值快照集)或「Measure-
ment Format」(測量值格式)；否則
請跳至步驟 3。

3. 選取要儲存該測量的位置。

4. 輸入該測量的名稱，或使用預設
名稱，然後選取檔案類型。

5. 按一下 Save (儲存)。
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儲存使用者遮罩
1. 選取「File > Save」(檔案 > 儲存)

或「Save As > User Mask」(另存新
檔 > 使用者遮罩)。

2. 按一下「User Mask」(使用者遮
罩)。

3. 選取要儲存該遮罩的位置。

4. 輸入該遮罩的名稱，然後選取檔
案類型。

5. 按一下「Save」(儲存)。
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儲存長條圖資料
1. 選取「File > Save」(檔案 > 儲存)

或 「Save As > HistogramData」(另
存新檔 > 長條圖資料)。

2. 選取「Histogram」(長條圖)。 根
據先前的選項，您可能需要選取
「More > Histogram Data」(更多 >
長條圖資料) 來顯示長條圖選項。

3. 選取要儲存該長條圖的位置。

4. 輸入該長條圖的名稱，然後選取
檔案類型。

5. 按一下「Save」(儲存)。
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儲存時序註記
1. 選取「File > Save」(檔案 > 儲存)

或 「Save As > Timestamp Table」
(另存新檔 > 時序註記表)。

2. 按一下「Timestamp」(時序註記)。
根據先前的選項，您可能需要選取
「More > Timestamp Table」(更多 >
時序註記表)來顯示「Timestamp」
(時序註記) 選項。

3. 按一下「Options...」(選項...) 以指
定「Source」(來源)或「FastFrame
Data Range」(快速圖框資料範圍)；
否則請跳至步驟 4。

4. 選取要儲存該時序註記的位置。

5. 輸入該時序註記的名稱，然後選
取檔案類型。

6. 按一下「Save」(儲存)。
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複製結果到剪貼簿
使用下列程序，設定要複製到 Microsoft 剪貼簿之影像、波形或測量值的輸出內容和格式。

1. 選取Edit > Copy Setup...(編輯>複製
設定...)。

2. 按一下 Images (影像)、Waveforms
(波形) 或 Measurements (測量值) 索
引標籤，然後選取所需選項。
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如果要複製影像、波形或是測量值，請使用下列程序：

1. 選擇您要複製的項目。

2. 選取 Edit > Copy (編輯>複製)，或
是按下 Ctrl + C。

3. 按下 Ctrl + V，便可將該項目貼入
Windows 應用程式。
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列印輸出
1. 若要進行列印，請按下列印按

鈕，或選取「File > Print」(檔案
> 列印)。 如有必要，請在「Page
Setup」(版面設定) 對話方塊中更
改版面配置。

「Print」(列印) 和 Page Setup (版面設
定) 對話方塊依所使用印表機而有差
異。

2. 按一下 Page Setup... (版面設定...)。

3. 選擇列印參數。
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執行應用軟體
您可以在儀器上免費使用每個應用程式 10 次。這些應用程式會提供特定應用程式的測量解決方案。
下面將介紹一些使用範例。同時也提供其他套件。 您的儀器可能無法使用某些應用程式。如需詳細資
訊，請聯絡 Tektronix 代理商或造訪我們的網站 www.tektronix.com。

使用DDRA記憶體匯流排分析，以自動辨識DDR1、LP-DDR1、LP-DDR2、LP-DDR3、DDR2、DDR3、
DDR4、DDR3L、GDDR3 和 GDDR5 讀取和寫入。

使用 DJA DPOJET 抖動和眼狀圖分析，進一步準確地量測複雜的時脈、數位和串列資料訊號。
DPOJET Essentials 為所有型號隨附的標準配備。

使用 D-PHY 進行 MIPI D-PHY 發送器偵錯 、特性和相容性測試 (需要選項 DJA)。

使用 DSPT Display Port Compliance Software (顯示埠相容性軟體)，以確認 IC、主機板和顯示卡的設
計。

使用 DVI Compliance Test Solution Software (相容性測試解決方案軟體) 進行 DVI 實體層相容性測試。

使用 ERRDT Frame and Bit Error Rate Detector (圖框和位元錯誤率偵測器) 偵測高速串列標準中的錯誤
(需要選項 ST6G)。

使用 ET3，可以執行 10/100/1000 Base-T Ethernet 相容性測試。

使用 HT3 HDMI Compliance Test Software (HDMI 相容性測試軟體) 為 ≥4 GHz 型號進行 HDMI 相容性
測試。

使用 HT3DS HDMI Direct Synthesis for HDMI 1.4 (需要 HT3) 進行 HDMI 分析。

使用 LT Waveform Limit Testing (波形極限測試)，以比較擷取的波形以及您設定的容許度界限。

使用 MOST Essentials 進行 MOST50 和 MOST150 電子相容性和偵錯測試。

使用 MTH Communication Mask Testing Software (通訊波罩測試軟體)，可進行 ≥4 GHz 型號的波罩相容
性測試。

使用 MTM Communication Mask Testing Software (通訊遮罩測試軟體) 以在 <4 GHz 型號上進行遮罩相
容性測試。

針對 Gen3 使用 PCE3 PCI-Express 相容性測試。 搭配 DPOJET 使用。

針對 Gen1 和 Gen2 使用 PCE 相容性測試。 可以和 DPOJET 或 RTE 搭配使用。

使用 PWR Power Measurement Software (功率測量軟體)，可以快速測量並分析電源供應開關裝置和磁
性元件的功率消耗。

使用 SLA 和 SLE 串列資料連結分析以模擬串列資料波道、解除嵌入治具以及新增或移除發射器均
等功能。SLA 新增具有均等功能的波形程序。

使用 SR-810B 啟用 8B10B 訊號的串列觸發和分析。

使用 SR-AERO 以進行 MIL-STD-1553 串列觸發與分析。

使用 SR-AUTO 進行 CAN、LIN 和 FlexRay 訊號的串列觸發、偵錯、解碼和分析。

使用 SR-COMP 啟用 RS-232/422/485/UART 訊號的串列觸發和分析。

使用 SR-DPHY 進行 MIPI-DSI1 和 MIPI-CSI2 串列分析。

使用 SR-EMBD 啟用 I2C 和 SPI 訊號的串列觸發和分析。
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使用 SR-ENET 以進行 Ethernet 訊號的串列分析。

使用 SR-PCIE 串列資料相容性與分析 (需要 ST6G 才能進行串列觸發)。

使用 SR-USB 啟用 USB2.0 和 USB3.0 訊號的串列觸發和分析。

使用 ST1G 或 ST6G 串列通訊協定觸發軟體，可以為高速串列或資料通訊協定的 8 B/10 B 資料進行
觸發和解碼。通訊協定觸發至 6.25 GS/s。

使用 SVP、SVM 和 SVE 頻譜分析應用程式來確認寬頻設計並辨識寬頻頻譜事件。

使用 SVO 進行靈活的 OFDM 分析，需要 SVE。

使用 SVT 進行穩定時間測量 (頻率和相位)，需要 SVE。

使用 USB 可以辨識 USB 2.0 訊號特徵，包括遮罩測試和參數測試。

使用 USB3 以確認、辨識、偵錯並相容性測試 USB 3.0 系統 (需要選項 DJA)。

使用 VET 啟用視覺觸發和搜尋。

&#x4f7f;&#x7528; XGBT &#x9032;&#x884c; 10GBASE-T Ethernet &#x5be6;&#x9ad4;&#x5a92;&#x9ad4;&#x-
9644;&#x52a0; (PMA) &#x5be6;&#x9ad4;&#x5c64; (PHY) &#x96fb;&#x5b50;&#x76f8;&#x5bb9;&#x6027;&#
x6e2c;&#x8a66;&#x3002;

請依照應用軟體隨附的指示說明進
行安裝。如果要執行軟體，請選取
Analyze (分析)，然後選取應用程式。
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應用範例
本節將介紹本儀器在一般故障排除工作中的使用範例，及其擴充使用方式。

捕捉間歇性異常
設計工程師經常面對的一大難題，就是找出間歇性故障的發生原因。 如果您知道自己要尋找哪種異常
狀況，您就可以輕鬆地設定示波器進階觸發功能，隔離找出該異常狀況。 然而，當您不知道自己要尋
找哪種異常狀況時，找出偶發異常的過程就會顯得十分冗長而耗時。尤其在使用傳統數位儲存示波器
只能提供極慢波形擷取速率時，更是如此。

加入 DPX 技術之數位螢光示波器所特別提供的 FastAcq 快速擷取模式，可讓您在數秒鐘或數分鐘之內
找出這類異常狀況。一般的 DSO 通常要花上好幾個小時、甚至幾天，才能找出此類異常事件。

使用下列程序來捕捉間歇性異常狀況。

1. 將探棒連接到輸入訊號源。

2. 按下 Autoset (自動設定)。

MSO/DPO70000DX、MSO/DPO70000C 和 DPO7000C 系列

MSO5000 和 DPO5000 系列
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3. 選取 Display > Display Persistence >
Infinite Persistence (顯示> 持續顯示
> 無限餘輝)。此例中，您 將查看
時脈訊號。在觀察訊號 1–2 分鐘
之後， 以及從其他位置尋找問題
之前，請先移至步驟 4。

4. 按下 FastAcq (快速擷取)。

MSO/DPO70000DX、MSO/DPO70000C 和 DPO7000C 系列

MSO5000 和 DPO5000 系列

5. 尋找出現在訊號中的突波、暫態
訊號或其他隨機異常。此例中，
FastAcq 僅在執行幾秒鐘之後就找
到 300 ns 的正突波。
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6. 如果要觸發在步驟 5 找到的突
波，請選取「Glitch Setup...」(突波
設定...)。

7. 選取適當的極性。

8. 按一下「Level」(位準)，再依照您
在步驟 5 找到的突波設定位準。

9. 按一下「Width」(寬度)，再依照您
在步驟 5 找到的突波設定寬度。

如果您要讓觸發系統將高頻率脈
衝視為單一脈波，請檢查HF濾波
功能。

10. 按一下 E-mail on Trigger (依觸發傳
送電子郵件) 「On」(開啟)。 ( 請
參閱頁80，設定「依事件發出電
子郵件」)

11. 按下 Single (單一擷取)可觸發單一
突波。
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MSO5000 和 DPO5000 系列
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使用延伸式桌面和有效記錄的 OpenChoice 架構
工程師經常需要記錄自己的實驗工作，以供日後參考。您可能不想要將螢幕參數一次顯示和波形資料
先儲存到 CD 或 USB 記憶體裝置，以後再產生報告；這時您可以嘗試使用 OpenChoice 架構，即時記錄
您的工作。

如果要將儀器加入到設計和文件撰寫程序，請使用下列程序。

注意。 在 64 位元系統上，您將需要 64 位元相容裝置驅動程式和應用程式軟體。

1. 將 Microsoft Word 或 Excel 載入本
儀器。

2. 連接第二台監視器。 ( 請參閱
頁10，新增第二台顯示器)

3. 開啟Microsoft Word，再將Word視
窗拖曳到延伸的桌面。

4. 按一下 TekScope 便可恢復到儀器
應用程式。
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5. 選取 Edit > Select for Copy > Full
Screen (bitmap) [(編輯>選取以複製
>全螢幕 (點陣圖))]。

6. 按下 Ctrl+C。

7. 在您要放置螢幕參數一次顯示的 Word 文件位置中按一下滑鼠，再按下 Ctrl+V。

快速秘訣
本儀器隨附多種專門設計的OpenChoice 軟體工具，可提供最大效能以及與其餘設計環境的連接性。

在匯流排上觸發
您可以使用您的儀器觸發 I2C、SPI、RS-232/422/485/UART、MIPI DSI-1、MIPI CSI-2、8B/10B、USB、
CAN和平行匯流排。該儀器可以顯示實體層 (如類比波形)和通訊協定層級資訊 (就像數位和符號波形)。

注意。 某些儀器不提供某些觸發類型。

若需要詳細的匯流排觸發程序，請使用下列程序：( 請參閱頁73，觸發並列匯流排) 和 ( 請參閱頁75，
觸發串列匯流排)

若要設定匯流排觸發：

1. 選取「Vertical > Bus Setup」(垂直
> 匯流排設定)。
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2. 選取匯流排類型。

3. 如果您已經選取「Serial」(串列)
匯流排類型，請選取串列匯流排
類型。

4. 指定元件。

5. 選取「Trig > Bus Setup」(觸發 >匯
流排設定)。

6. 選取您設定的匯流排。

7. 選取「Trigger On」(觸發開啟) 以
選取想要的觸發功能。

8. 根據您選擇的「Trigger On」(觸發
開啟) 選項，您可能還需要選擇其
他選項。

在視頻訊號上觸發
本儀器支援觸發 NTSC、SECAM、PAL 和高解析度訊號。

如果要在視頻圖場上觸發：

注意。 視訊觸發類型僅適用於 DPO7000C、MSO5000 和 DPO5000 系列儀器。
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1. 選取 Trig > A Event (Main) Trigger
Setup...(觸發> A事件(主要)觸發設
定...)。

2. 在 A Event (A 事件) 索引標籤中設
定 A 觸發方式和來源。

選取 Format > 525/NTSC (格式>
525/NTSC)。

3. 選取 Trigger On > Field (觸發開啟 >
圖場)。

選取Odd (奇數)、Even (偶數)或All
(全部)圖場。

在排線上觸發
若要觀察圖場中的視頻線：
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1. 選取 Trig > A Event (Main) Trigger
Setup...(觸發> A事件(主要)觸發設
定...)。

2. 在 A Event (A 事件) 索引標籤中設
定 A 觸發方式和來源。

選取 Format > 525/NTSC (格式 >
525/NTSC).

3. 選取 Trigger On > All Lines (觸發開
啟 >全部排線)。
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建立 Tektronix 示波器和邏輯分析儀之間的資料關聯
幾乎每一項設計都是包括高速時脈邊緣和資料速率的高速設計。針對這些設計，您必須觀察高速數位
訊號與電路中複雜數位事件之間相關的類比特徵。iView 就是用來連接數位世界和類比世界的窗口。
iView 功能可以流暢地為 Tektronix 邏輯分析儀和示波器自動依據時序關聯資料，讓您只要按一下滑鼠，
就可以將示波器的類比波形傳輸到邏輯分析儀顯示畫面。同步檢視時序關聯的類比和數位訊號，並在
極短時間指出捉摸不定的突波和其他問題的來源。

您可利用 iView 外部示波器電纜線，將邏輯分析儀連接到 Tektronix 示波器，建立這二部儀器之通訊。
您可以從 TLA 應用系統功能表啟動「外部示波器」精靈，依照其步驟執行，完成連接邏輯分析儀和
示波器 iView 電纜線的整個程序。

也提供設定視窗，幫助您確認、變更和測試示波器設定。擷取和顯示波形之前，須先使用「新增外部
示波器」精靈建立 Tektronix 邏輯分析儀和示波器的連線。

1. 從邏輯分析儀的系統功能表，選
取Add iView External Oscilloscope...
(新增 iView 外部示波器...)。

2. 選取示波器型號。

3. 依照螢幕指示，然後按一下 Next
(下一步)。

4. 如需更多邏輯分析儀與示波器關聯
資料的詳細資訊，請參閱Tektronix
邏輯分析儀的說明文件。
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附錄 A

清潔
使用這些程序來清潔您的儀器。如果需要其他清潔，請交由合格的人員處理。

清潔外部
使用不沾絨質的乾布或軟毛刷，清潔底盤外面。如果還有灰塵，可用沾上濃度 75% 的異丙醇溶劑的布
或紗布。控制及接頭周圍的狹窄處，可用紗布清潔。不可使用有磨蝕性的清潔劑清潔底盤。

使用濕的清潔布來清潔 On/Standby (開啟/待機) 開關。不可以直接弄濕開關。

小心。 不當的清潔劑、方法或施力會損傷儀器。請勿使用可能損傷示波器塑膠部分的化學清潔劑。
只可用去離子水來清潔前面板按鈕。使用濃度 75% 的異丙醇溶劑當做清潔劑，並以去離子水清洗。若
要使用其他類型的清潔劑，請先洽詢 Tektronix 服務中心或服務人員。

清潔外部時為防止弄濕儀器內部，只能以適量液體沾濕布或塗抺器。
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附錄 B

取得最新的示波器應用程式和版本發行
和儀器一同訂購的選購應用程式最新版本可能沒有安裝在您的儀器上。 下列下載位置是取得最新軟體
版本最快速且最簡單的方法。

若要下載最新的軟體版本，請前往 Tektronix 網站 (www.tektronix.com) 的首頁，並找出該頁面上的「下
載」區段。請在「ENTER MODEL NUMBER」(輸入型號)文字方塊中，輸入應用程式名稱，並在「Select
Download Type」(選取下載類型) 下拉功能表中選取「Software」(軟體)。

注意。 網頁上提供的發行通知檔案可能比可下載執行檔案中的 readme.txt 檔案，包含更多最新的資訊。

若要定義搜尋準則，請使用「ENTER MODEL NUMBER」(輸入型號) 文字方塊中的應用程式標題。 例
如，使用關鍵字「DPOJET」搜尋並下載最新版的 DPOJET。

如果您一同購買儀器和應用程式，您的 Tektronix 授權金鑰可讓您使用應用程式。

如果您要升級，請遵照 Readme.txt 檔案中關於如何安裝新的 Tektronix 授權金鑰的指示，來啟用應用程
式。
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附錄 C

TPP0500 和 TPP1000 500 MHz 和 1 GHz 10X 被動探棒指示
071-2809-xx

Copyright© Tektronix, Inc. 版權所有。

操作資訊
TPP0500 & TPP1000 10X被動探棒是含有 10X衰減的精簡被動探棒，其設計是供Tektronix MSO/DPO4000B
與 5000 系列示波器所使用。

這些探棒沒有使用者或 Tektronix 可自行維修的零件。

將探棒連接至示波器
如下列圖解所示連接探棒。
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補償探棒
MSO/DPO5000: 請執行以下步驟來補償探棒：

1. 將探棒連接至示波器波道。

2. 將探棒連接至示波器前面板上的探棒補償輸出端點。

3. 選取「Vertical > Probe Cal」(垂直 > 探棒校準)。

4. 選取和探棒連接的波道標籤。

5. 在功能表的「Probe Compensation」(探棒補償)區段中，按一下「Compensate Probe」(補償探棒)按鈕。

警告。 為了避免電擊，請在進行此調整時，才連接至示波器上的 PROBE COMP (探棒補償) 訊號。

如果探棒補償失敗，請確認訊號和接地的連接有確實連接至示波器上的 PROBE COMP (探棒補償) 接
頭。 也請檢查探棒頭的接地連接是否確實、rigid 或 pogo 鉤頭有確實地固定在探棒頭，以及鉤頭是否
有確實地連接至探棒頭。

標準配件
隨附於探棒的標準配件如下所示。

警告。 為避免使用探棒或配件時受到電擊，請將手指置於探棒本體和配件手指保護層的後面。
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項目 描述

鉤頭

將鉤頭壓入探棒頭，然後將鉤子箝制住電
路。

重新編排 Tektronix 零件編號 013-0362-XX

微鈎頭

使用此鈎頭來存取狹小空間中的測試點。
將鉤頭壓入探棒頭，然後將鉤子箝制住電
路。

重新編排 Tektronix 零件編號 013-0363-XX

Rigid 鉤頭

此鉤頭已預先安裝在探棒上。

重新編排 Tektronix 零件編號 206-0610-XX

Pogo 鉤頭

此彈性負載鉤頭允許電路板的相容測試。

重新編排 Tektronix 零件編號 206-0611-XX

附彈簧夾的接地導線

將導線連接至探棒頭接地，然後連接至電
路接地。

重新編排 Tektronix 零件編號 196-3521-XX

接地彈簧

將彈簧接上探棒頭上的基帶，以測量在附
近具有接地連接的測試點 (<0.75 英吋，標
準；XX 英吋，短)。

重新編排 Tektronix 零件編號：

016-2028-XX (長，2 ea.)

016-2034-XX (短，2 ea.)
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選購配件
可為您的探棒訂購下列配件。

配件 Tektronix 零件編號

接地導線，夾式，6 英吋 196-3198-xx

接地導線，彈簧夾，12 英吋 196-3512-xx

MicroCKT 測試頭 206-0569-xx

電路板測試點/PCB 轉接器 016-2016-xx

精簡探棒頭 Ckt 電路板測試點 131-4210-xx

電線，列印佇列，32 AWG 020-3045-xx

更換探棒頭
訂購 Tektronix 零件編號 206-0610-xx 以更換 Rigid 鉤頭，或訂購零件編號 206-0611–xx 以更換 Pogo 插
頭。

規格
表格 1: 電子和機械規格

特性 TPP0500 TPP1000

頻寬 (–3 dB) 500 MHz 1 GHz

系統上升時間 (一般) <350 ps <700 ps

系統輸入電容 Rigid 鉤頭： 3.9 pF ±0.3 pf
Pogo 插頭： 5.1 pf ±0.5 pf

系統衰減精確度 10:1 ±2.2%

直流時的探棒系列電阻 9.75 MΩ ±0.5%

直流時的系統輸入電阻 10 MΩ ±2%

傳輸延遲 ~5.67 ns

最大輸入電壓 300 V均方根 CAT II

纜線長度 1.3 公尺，±3 公分
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性能圖

當進行浮接測量時，請參照參考導線衰減曲線。

表格 2: 環境規格

特徵 描述

溫度

作業中

非作業中

–15 ℃ 到 +65 ℃ (+5 ℉ 到 +149 ℉)

–62 ℃ 到 +85 ℃ (–80 ℉ 到 +185 ℉)

濕度

作業中

非作業中

5% 到 95% 相對溼度，最高溫達 30 °C

5% 到 45% 相對溼度 (於 30 ℃)，最高 50 ℃

高度

作業中

非作業中

最高 4.6 公里 (15,000 英呎)

最高 12.2 公里 (40,000 英呎)
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表格 3: 檢定證明及相容性

特徵 描述

EC 符合性聲明 經證實符合如下歐盟官方期刊所列出之規格：

低電壓 Directive 2006/95/EC：

EN61010-031： 2002

類別 這一類產品的範例

CAT III 分散式等級的主要、固定安裝

CAT II 區域等級的主要、應用、可攜式的設備

測量類別說明

CAT I 電路未直接連接到主要設備。

污染等級 2 請勿在可能會有導電性污染物的環境中作業 (依據 IEC 61010-1 定義)。評估
僅限於室內。

其他的安全標準 UL61010B-1，初版與 UL61010B-2-031，初版。

CAN/CSA-C22.2 編號 1010.1-92 與 CAN/CSA-C22.2 編號 1010.2.031-94

IEC61010-031：2002

設備回收。 本產品已遵守歐盟要求，符合「廢電子電機設備規範 (WEEE)」的「Directive
2002/96/EC」。如需更多回收選項的詳細資訊，請參閱 Tektronix 網站 (www.tektronix.com) 支
援∕服務區。

安全摘要
請檢視下列的安全警告以避免傷害，並預防對此產品或任何相關產品的損害。為避免潛在的危險，請
僅依照指示使用此產品。 未依照指示使用探棒或配件將可能造成觸電或火災的危險。

避免火源或身體傷害
接地參考示波器使用: 當使用接地參考示波器 (例如，DPO、MSO 和 TDS 系列示波器) 時，請勿浮
接此探棒的參考導線。 參考導線必須連接至地面電位 (0 V)。

正確地連接與中斷連接: 將探棒連接至測試中的電路之前，請先將探棒輸出連接至測量儀器。 從
測量儀器拔掉探棒前，請先從測試中的電路拔掉探棒輸出和探棒參考導線。

避免電擊: 為避免受傷或喪命，當探棒或測試線與電壓來源連接時，請勿連接它們或中斷與它們的
連接。

觀察所有的端子功率: 為了避免火災或是電擊的危險，請注意產品上的功率及標記。在與產品連接
之前，請先參閱產品手冊以便進一步瞭解有關功率的資訊。

避免電擊: 當使用探棒零件時，請勿超出探棒或其零件的最低功率，包括測量類別和電壓功率 (取其
低者)。

避免電量超載: 為了避免火災或是火災的危險，請勿將電壓連接至任何輸出，包括參考輸入，這和
接地不同，因為該輸入超過最大功率。

避免電路外露與請勿在蓋子未蓋上之前即進行操作: 當電源開啟時，請勿碰觸外露的連接器及
元件。
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檢查探棒和探棒配件: 在每次使用前，請檢查探棒和零件是否有損壞 (探棒主體、零件、纜線外皮
等是否有切斷、撕裂、瑕疵)。 如有損壞，請勿使用。

請勿在潮濕的狀態下操作:

請勿在易燃易爆的空氣中操作:

請維持產品表面的清潔與乾燥:

此手冊中的安全規定和符號規定
本手冊可能會出現下列規定：

警告。 警告聲明中指明了可能導致受傷或喪命的情況或操作。

小心。 小心聲明中指明了可導致損壞此產品或其他物品的情況或操作。

產品上的符號: 下列符號可能會出現在產品上：

聯絡 Tektronix

網址： www.tektronix.com

電話： 1-800-833-9200

地址： Tektronix, Inc.
部門或姓名 (如果已知)
14200 SW Karl Braun Drive
P.O. Box 500
Beaverton, OR 97077
USA

電子郵件信箱： techsupport@tektronix.com

保固資訊
如需保固資訊，請造訪 www.tektronix.com/warranty
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附錄 D

P6616 一般功能邏輯探棒說明
071-2831-00

Copyright© Tektronix, Inc. 版權所有。

產品介紹
P6616 一般功能邏輯探棒會將 Tektronix MSO5000 系列和MSO4000B 系列的混合訊號示波器連接至您目標
系統上的數位匯流排和訊號。探棒包含分割在兩個導線組 (GROUP 1和 GROUP 2) 之間的 16資料波道。

每組中的第一條導線是以藍色絕緣體作為識別，其餘的七條導線皆為灰色。 所有導線頂端都有接地的
連接。 您可以個別將探棒導線連接至目標系統，或使用探棒頭支架將導線集結成群組。

將探棒連接至示波器
如下列圖解所示連接探棒。

1. 將探棒標籤面朝上插入示波器上的接頭。

2. 若要移除探棒， 請按下旁邊的按鈕，並拉出探棒。
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將探棒連接至您的電路
使用顯示在這些說明背後的接頭和轉接器，將探棒連接至電路。 依您的需求選取最好的方法，然後
繼續進行「設定探棒」。

設定探棒
若要設定和檢視數位波道參數，請執行下列步驟：

在MSO5000 系列儀器上，選取「Vertical>Digital Setup」(垂直>數位設定)，或按下「D15-D0」按鈕。

在 MSO4000B 系列儀器上，按下「D15–D0」按鈕。

下列參數可在每個數位波道上設定：

臨界值電壓和垂直位置 (預設的臨界值設定為 1.4 V)

訊號高度和位置 (執行一次可設定全部 16 個波道)

波道標籤

若要設定和檢視匯流排特性，請執行下列步驟：

在 MSO5000 系列儀器上，使用「Bus Setup」(匯流排設定) 功能表中的控制項。

在 MSO4000B 系列儀器上， 按下「B1」到「B4」按鈕。

這些設定畫面可讓您設定並檢視匯流排特性，例如：

時脈類型

匯流排類型 (串列或並列)

匯流排寬度

顯示格式 (十六進位、二進位或 ASCII 符號)

某些示波器型號會提供並列匯流排設定資訊。 然而，針對其他匯流排，如 SPI 和 I2C，您必須擁有適
當的選項。 請參閱您的示波器手冊或產品資料表，以取得術語和訂購的詳細資料。

功能檢查
邏輯活動會立即顯示在所有連接並作用中的波道上。 如果您沒有看見作用中的訊號：

1. 請按下「Trigger」(觸發) 按鈕。

2. 選取「Edge」(邊緣) 觸發類型。

3. 選取您要設定作為來源的波道。

4. 在 MSO4000B 系列儀器上，按下「Autoset」(自動設定) 按鈕。

如果您沒有看見作用中的訊號，請嘗試其他的探棒波道 (或類比探棒)，以驗證測試點的電路活動。
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常見的應用程式
1. 使用 P6616 探棒以檢視系統匯流排上的數位訊號。

2. 請使用類比探棒，例如 TPP0500 或 TPP1000 被動探棒以檢視類比波形資訊。

配件
下列標準配件會隨附於探棒，並顯示在下頁圖解中。

項目 描述 數量 零件號碼

— 邏輯探棒配件 項目 1–6 020-2662-XX

1 擴充接地鉤頭 一組 20 支 020-2711-XX

2 探棒頭 一組 10 支 131-5638-11

3 IC 抓鉤 一組 20 支 020-2733-XX

4 探棒頭支架 2 ea 352-1115-XX

5 8” 接地導線 一組 2 條 020-2713-XX

6 3” 接地導線 一組 8 條 020-2712-XX

說明 1 1 ea 071-2831-XX

1 說明會隨附於探棒， 但不會在配件中。 說明可從 www.tektronix.com/manuals 網站下載。

可為您的探棒訂購這些選購配件。

描述 零件號碼

P6960 Probe D-MAX 引腳對方形針座轉接器 NEX-P6960PIN
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規格
表格 4: 電子和機械規格

特性 描述

輸入波道 16 個數位

輸入電阻 100 kΩ ±1.0%

輸入電容 3.0 pF

輸入訊號 Swing

最小 400 mV p-p

最大 探棒頭的電壓為 30 V p-p，≤200 MHz (集中在直流臨界值電壓周
圍)

探棒頭的電壓為 10 V p-p，≥200 MHz (集中在直流臨界值電壓周
圍)

最大不具破壞性的輸入訊號 ±42 V

使用者定義臨界值範圍 ±40 V

最小可檢測的脈波寬度 1 ns

數位波道到數位波道歪斜 200 ps

探棒長度 1.3 公尺 (4.27 英呎)

表格 5: 環境規格

特性 描述

溫度

作業中 0 ℃ 到 +50 ℃ (+32 ℉ 到 +122 ℉)

非作業中 –55 ℃ 到 +75 ℃ (–67 ℉ 到 +167 ℉)

濕度

作業中 5% 到 95% 相對溼度

非作業中 10% 到 95% 相對溼度

高度

作業中 最高 4.6 公里 (15,092 英呎)

非作業中 最高 15 公里 (50,000 英呎)

設備回收。 本產品已遵守歐盟要求，符合「廢電子電機設備規範 (WEEE)」的「Directive
2002/96/EC」。如需更多回收選項的詳細資訊，請參閱 Tektronix 網站 (www.tektronix.com) 支
援∕服務區。
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安全摘要
為避免潛在的危險，請僅依照指示使用此探棒。

正確地連接與中斷連接: 將探棒連接至測試中的電路之前，請先將探棒輸出連接至測量儀器。 從
測量儀器拔掉探棒前，請先從測試中的電路拔掉探棒輸出和探棒接地。

觀察所有的端子功率: 為了避免火災或是電擊的危險，請注意產品上的功率及標記。在與產品連接
之前，請先參閱產品手冊以便進一步瞭解有關功率的資訊。

請勿在蓋子未蓋上之前即進行操作: 當電源開啟時，請勿碰觸外露的連接器及元件。

避免電路外露: 當電源開啟時，請勿碰觸外露的連接器及元件。

懷疑有故障時請勿操作: 若您懷疑此產品已遭損壞，請讓合格的維修人員進行檢查。

請勿在潮濕的狀態下操作: 請勿在易燃易爆的空氣中操作。

請維持產品表面的清潔與乾燥:

此手冊中的安全規定和符號
本手冊可能會出現下列規定：

警告。 警告聲明中指明了可能導致受傷或喪命的情況或操作。

小心。 小心聲明中指明了可導致損壞此產品或其他物品的情況或操作。

產品上的符號: 此符號可能會出現在產品上：
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附錄 D

聯絡 Tektronix
網址： www.tektronix.com

電話： 1-800-833-9200

地址： Tektronix, Inc.
部門或姓名 (如果已知)
14200 SW Karl Braun
Drive P.O. Box 500
Beaverton, OR 97077
USA

電子郵件信箱： techsupport@tektronix.com

保固資訊
如需保固資訊，請造訪 www.tektronix.com/warranty。
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附錄 D

將探棒連接至電路
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ENGLISH TERMS
ARM 狀態燈, 67
Autoset Undo (復原自動設

定), 33
B 事件掃描, 71
CAN, 164
CAN 觸發

已定義, 66
D15 - D0 按鈕, 53
Display Remote (遠端顯示), 9
ESD

預防, 4
FastAcq/WfmDB 調色盤, 90
I2C, 164
iView, 168
Linear (線性) 內插法, 86
MagniVu, 53
MIPI CSI-2, 164
MIPI DSI-1, 164
MultiView Zoom, 91
MyScope

使用, 142
新增控制視窗, 138
編輯, 143

OpenChoice
範例, 163

Parallel, 164
Pinpoint 觸發, 61
READY 狀態燈, 67
Screen (螢幕) 游標, 117
Sin(x)/x 內插法, 86
SPI, 164
TRIG'D 狀態燈, 67
Undo Last Autoset (復原上一次

自動設定), 33
V Bars (垂直線條) 游標, 117
Wave Inspector, 97
X-Y 顯示格式, 85
X-Y-Z 顯示格式, 85
Y-T 顯示格式, 85

一
一般觸發模式, 61
一般調色盤, 90

丨
中斷電源, 8
串列, 164
串列錯誤偵測器, 127

丶
主要觸發, 62, 68

人
介面圖, 19
作業系統復原, 13
使用者偏好, 33
使用者定義調色盤, 90
使用者標記, 99
依事件採取動作

設定, 78
依事件發出電子郵件

設定, 80
依觸發傳送電子郵件, 79
停止擷取, 37
側面板圖, 16
儀器設定

儲存, 149
叫出, 150

儲存
時序註記, 154
波形, 145
測量值, 151
螢幕捕捉, 144
設定, 149
遮罩, 152
長條圖資料, 153

儲存數位波形, 148

入
內插法, 35, 86
全螢幕方格圖樣式, 88

八
其他測量值, 111

刀
分析波形, 108
列印, 157

前置觸發, 61, 62
前面板圖, 14

力
功能表, 25
加強 DSP 頻寬, 41
加強型頻寬, 41

勹
包封擷取模式, 35

匚
匯出 請參閱 儲存
匯流排, 164

設定, 51
設定並列匯流排, 49
設定串列匯流排, 48
設定匯流排, 47

十
十字線方格圖樣式, 88

厶
參考位準, 116
參考色彩, 91

又
取樣

內插即時, 34
即時, 33
等時, 34

取樣擷取模式, 35
取樣過程

已定義, 33

口
叫出

波形, 147
設定, 150

可變餘輝, 84
向量

波形顯示方式, 83
單次程序, 37
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單色灰色調色盤, 90
單色綠色調色盤, 90

囗
圖框方格圖樣式, 88

土
垂直位置, 30
垂直位置和自動設定, 32
增亮樣值

波形顯示方式, 83

夕
多塊縮放區域, 93

女
如何執行

使用 MagniVu, 53
使用 Wave Inspector, 97
搜尋整個波形並新增標

記, 99
管理長記錄長度波形, 97

宀
安全鎖, 9
安裝, 1
寬度觸發

已定義, 65

山
峰值檢測擷取模式, 35

工
左右移動, 97, 98

干
平均擷取模式, 35

广
序列波罩測試, 133

廴
延伸式桌面, 10, 163
延遲觸發, 62, 68

弓
強制觸發, 61

彳
後置觸發, 61, 62
後面板圖, 16

心
快照, 114, 115
快速圖框, 55

圖框搜尋工具, 59
快速擷取, 40, 160
應用程式範例, 160
應用軟體, 158

手
按滑鼠右鍵的功能表, 25
按鈕

D15-D0, 53
播放∕暫停, 98
設定 / 清除標記, 100

振幅測量值, 110
捲動模式, 44
捲動模式互動, 44
捲動縮放波形, 94, 96
捷徑功能表, 25
探棒

P6616, 178
TPP0500, 171
TPP1000, 171
偏移校正, 33
校準, 33
補償, 33

控制面板, 14
控制面板圖, 21
搜尋, 99, 100, 102
播放, 98
播放-暫停模式, 98
播放∕暫停按鈕, 98
操作規格, 2
擷取

取樣, 33
輸入波道和數位器, 33

擷取模式
已定義, 35
改變, 36

攴
數位波形

儲存, 148
數位波道

訊號輸入, 45
設定, 46
類比特性, 54

斤
新增濾波功能

使用者可定義, 122

方
方格圖方格圖樣式, 88
方格圖樣式, 88
旋鈕

縮放, 97
飛梭, 98

日
日期和時間, 89
時序註記, 57

儲存, 154
已定義, 55

時間測量值, 110
暫停, 98

木
校準, 27
極限測試, 136
標籤, 87

匯流排, 47
數位波道, 46
螢幕文字, 87

標記, 99, 100, 102
模式觸發

已定義, 65
樣式鎖定觸發, 65

欠
次序觸發, 68

水
水平位置

已定義, 30
相加 (and) 算術運算波

形, 123
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水平刻度
相加 (and) 算術運算波

形, 123
水平延遲, 82
水平標記, 93
水平模式

選項, 37
水平線條游標, 117
波形

使用者標記, 99
儲存, 145
分析, 108
叫出, 147
左右移動, 97, 98
搜尋和標記, 99
播放, 98
播放-暫停, 98
暫停, 98
游標, 117
縮放, 97
顯示樣式, 83

波形記錄
已定義, 34

波形資料庫擷取模式, 35
波罩

自動設定, 134, 135
自動適應, 134
通過∕失敗測試, 135
邊際容許度, 134

波罩測試, 133
清潔, 169
清潔外部, 169
測量值, 108

儲存, 151
參考位準, 116
已定義, 110
快照, 114, 115
游標, 117
精確度, 33
統計, 114
自訂, 113
註解, 115

游標測量值, 117
溫階調色盤, 90

火
無限餘輝, 84

片
片段記憶體, 55

牛
物件

顯示, 88, 89

犬
狀態觸發

已定義, 65

目
直接列印, 157
相關說明文件, xv

矢
矮波觸發

已定義, 65

穴
突波

擷取, 35, 40, 160
觸發 開啟, 62

突波觸發
已定義, 65

竹
算術運算

任意濾波器, 122
波形, 121
編輯器, 121
色彩, 91

範例, 160
範圍, 113

糸
終端電壓, 43
統計, 114
網路連線, 9
線上說明, 24
縮放, 91, 97

方格圖尺寸, 98
旋鈕, 97

縮放方格圖尺寸, 92

耒
耦合

觸發, 61

自
自動捲動, 94, 96
自動觸發模式, 61
自動設定, 32

虫
螢幕參數一次顯示

儲存, 144
螢幕文字, 87

衣
複製, 155

見
規格

操作, 2
電源供應, 5

視窗觸發
已定義, 65

視覺觸發, 76
視頻

排線, 166
視頻觸發, 165

已定義, 65, 66

角
觸發

B 事件掃描, 71
並列匯流排, 73, 164
位準, 62
依觸發傳送電子郵件, 79
前置觸發, 61, 62
序列匯流排, 75, 164
延滯, 61
強制, 61
後置觸發, 61, 62
斜率, 62
概念, 61
模式, 61
狀態, 67
耦合, 61
視覺觸發, 76
讀值, 67
選項, 65
類型, 65

觸發事件
已定義, 61

觸發位準標記, 88
觸發位置, 70
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言
記錄檢視調色盤, 90
設定 / 清除標記按鈕, 100
設定∕保持觸發

已定義, 65
診斷, 26
說明, 24
說明文件, xv
調色盤, 90
讀值

觸發, 67

車
軟體

最新版本, 170
版本, 170
選配, 158

輸入檢查, 26
輸入訊號, 29
轉態觸發

已定義, 65

辵
通訊

測量值, 112
觸發, 已定義, 65

逾時觸發
已定義, 65

遠端顯示, 9
遮罩

儲存, 152
選擇觸發類型, 62
邊緣觸發

已定義, 65
邏輯分析儀

關聯資料, 168

酉
配件, 1

里
重疊圖框, 57

金
錯誤偵測器, 127
鎖定縮放波形, 94, 96
鎖，標準筆記型電腦, 9

長
長條圖

儲存, 153
長條圖測量值, 111
長條圖設定, 119
長記錄長度

管理, 97

門
開始擷取, 37
開機, 5
閘道寬度和解析度頻寬, 126
關閉電源, 7

阜
隨機雜訊, 35

隹
雙監視器, 10

雨
電源

移除, 8
電源供應器, 5

頁
預先定義的算術運算式, 121

預先定義的頻譜算術運算
式, 124

預設值設定, 31
預防 ESD, 4
頻寬限制, 42
頻譜分析, 124
頻譜層次調色盤, 90
頻譜算術運算式

進階, 125
顯示

持續, 84
樣式, 83
物件, 88, 89
色彩, 91

顯示圖, 19

飛
飛梭

旋鈕, 98

食
餘輝

顯示, 84

高
高解析度擷取模式, 35

黑
點

波形記錄點顯示方式, 83
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